Contents

1 Welcome to COPA-DATA help ........................................................................................................... 5

2 WPF element ................................................................................................................................... 5

3 Basics .............................................................................................................................................. 6
   3.1 WPF in process visualization ..................................................................................................... 7
   3.2 Referenced assemblies ............................................................................................................... 8
   3.3 Workflows .............................................................................................................................. 10
      3.3.1 Workflow with Microsoft Expression Blend .................................................................. 11
      3.3.2 Workflow with Adobe Illustrator ............................................................................... 11

4 Guidelines for designers .................................................................................................................. 12
   4.1 Workflow with Microsoft Expression Blend ......................................................................... 12
      4.1.1 Create button as an XAML file with Microsoft Expression Blend .................................. 12
   4.2 Workflow with Adobe Illustrator ............................................................................................ 16
      4.2.1 Bar graph illustration ....................................................................................................... 16
      4.2.2 WPF export ..................................................................................................................... 18
      4.2.3 Animation in Blend ......................................................................................................... 20

5 Guidelines for developers ................................................................................................................ 24
   5.1 Creation of a simple WPF user control with code behind function ....................................... 24
   5.2 Debugging the WPF user control in the Runtime .................................................................. 29
   5.3 Data exchange between zenon and WPF user controls ......................................................... 34
      5.3.1 Data exchange using dependency properties ................................................................. 34
      5.3.2 Data replacement via VSTA ............................................................................................ 38
   5.4 Access to the zenon (Runtime) object model from a WPF user control ............................... 40
      5.4.1 Access via VSTA "variable link" ..................................................................................... 40
      5.4.2 Access via marshaling ..................................................................................................... 44

6 Engineering in zenon ...................................................................................................................... 48
   6.1 CDWPF files (collective files) ............................................................................................... 48
   6.2 create WPF element ............................................................................................................... 49
   6.3 Configuration of the linking .................................................................................................... 49
      6.3.1 Properties ......................................................................................................................... 52
      6.3.2 Events ............................................................................................................................ 58
      6.3.3 Transformation ................................................................................................................. 59
6.4 Validity of XAML Files.................................................................62
6.5 Pre-built elements ..................................................................63
  6.5.1 Analog clock - AnalogClockControl ..................................64
  6.5.2 Bar graph vertical - VerticalBargraphControl .................65
  6.5.3 Progress bar - ProgressBarControl .................................66
  6.5.4 COMTRADE-Viewer .........................................................66
  6.5.5 Energy class diagram .......................................................79
  6.5.6 Pareto diagram .................................................................80
  6.5.7 Circular gauge control ......................................................83
  6.5.8 Sankey diagram ...............................................................87
  6.5.9 Temperature indicator - TemperatureIndicatorControl ....88
  6.5.10 Universal slider - UniversalReglerControl ...................89
  6.5.11 Waterfall chart ...............................................................91
  6.5.12 BACnet WPF Control ...................................................93
6.6 Display of WPF elements in the zenon web client .................109
  6.6.1 Engineering in the zenon Editor ........................................109
  6.6.2 VSTA code (complex) .....................................................109
  6.6.3 VSTA code (simplified) ...................................................111
6.7 Examples: Integration of WPF in zenon .................................112
  6.7.1 Integrate bar graph as WPF XAML in zenon .....................112
  6.7.2 Integrate button as WPF XAML in zenon .......................117
  6.7.3 Integrate DataGrid Control in zenon..............................123
6.8 Error handling ..................................................................130
1 Welcome to COPA-DATA help

ZENON VIDEO TUTORIALS

You can find practical examples for project configuration with zenon in our YouTube channel (https://www.copadata.com/tutorial_menu). The tutorials are grouped according to topics and give an initial insight into working with different zenon modules. All tutorials are available in English.

GENERAL HELP

If you cannot find any information you require in this help chapter or can think of anything that you would like added, please send an email to documentation@copadata.com.

PROJECT SUPPORT

You can receive support for any real project you may have from our customer service team, which you can contact via email at support@copadata.com.

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email sales@copadata.com.

2 WPF element

With the WPF dynamic element, valid WPF/XAML files in zenon can be integrated and displayed.

Note: In the zenon Editor, the standard tooltip for the WPF element is not displayed if a .wpf file is linked. Furthermore, in zenon Runtime, the zenon tooltip for WPF elements is not supported.

Information

All brand and product names in this documentation are trademarks or registered trademarks of the respective title holder.
3 Basics

XAML

XAML stands for **Extensible Application Markup Language**. The XML-based descriptive text developed by Microsoft defines graphic elements, animations, transformations, displays of color gradients etc. in Silverlight and WPF user interfaces. The use of XAML makes it possible to strictly separate design and programming. The designer prepares, for example, the graphical user interface and creates basic animations that are then used by the developers/project planners who create the application logic.

WPF

WPF stands for **Windows Presentation Foundation** and describes a graphics framework that is part of the Windows .NET framework:

- WPF provides a comprehensive model for the programmer.
- XAML describes, based on XML, the interface hierarchy as a markup language. Depending on the construction of the XAML file, there is the possibility to link properties, events and transformations of WPF elements with variables and functions of CD_PRODUCTNAME<.
- The framework unites the different areas of presentation such as user interface, drawing, graphics, audio, video, documents and typography.

For execution in zenon, Microsoft .NET framework version 4.6.2 or higher is required.

Information

Transparency

In order for WPF controls in which a transparent background has been defined to also be displayed as transparent, the following must be the case on the computer for both Editor and Runtime:

- The operating system must be at least Windows 8.1
- The .NET framework version 4.6.2 or higher must be installed

WPFs are not shown as transparent in Windows 7 or 8. Instead, the transparent areas are filled with the background color set on the zenon screen.
3.1 WPF in process visualization

XAML makes different design possibilities possible for zenon. Display elements and dynamic elements can be adapted graphically regardless of the project planning. For example, laborious illustrations are first created by designers and then imported into zenon as an XAML file and linked to the desired logic. There are many possibilities for using this, for example:

**DYNAMIC ELEMENTS IN ANALOG-LOOK**

![Image]

Graphics no longer need to be drawn in zenon, but can be imported directly as an XAML file. This makes it possible to use complex, elaborately illustrated elements in process visualization. Reflections, shading, 3D effects etc. are supported as graphics. The elements that are adapted to the respective industry environment make intuitive operation possible, along the lines of the operating elements of the machine.

**INTRICATE ILLUSTRATIONS FOR INTUITIVE OPERATION**

![Image]

The integration of XAML-based display elements improves the graphics of projects and makes it very easy to display processes clearly. Elements optimized for usability make operation easier. A clear display of data makes it easier to receive complex content. The flexible options for adapting individual elements makes it easier to use for the operator. It is therefore possible for the project planners to determine display values, scales and units on their own.

**CLEAR PRESENTATION OF DATA AND SUMMARIES**

![Image]

Grouped display elements make it possible to clearly display the most important process data, so that the equipment operator is always informed of the current process workflow. Graphical evaluations, display values and sliders can be grouped into an element and make quick and uncomplicated control possible.
INDUSTRY-SPECIFIC DISPLAYS

Elements such as thermometers, scales or bar graphs are part of the basic elements of process visualization. It is possible, using XAML, to adapt these to the respective industry. Thus equipment operators can find the established and usual elements that they already know from the machines in process visualization at the terminal.

ADAPTATION TO CORPORATE DESIGN

Illustrations can be adapted to the respective style requirements of the company, in order to achieve a consistent appearance through to the individual process screen. For example, the standard operation elements from zenon can be used, which can then be adapted to color worlds, house fonts and illustration styles of the corporate design.

3.2 Referenced assemblies

It is not just standard objects (rectangles, graphics, etc.) or effects (color gradients, animations, etc.) that can be displayed using the WPF elements, but also customized user controls (with logic in the code behind), which are referenced as assemblies.

For example, a user control that looks like a tacho and provides special properties and optical effects can be created, such as a Value property, which causes the pointer of the tacho to move and/or the corresponding value to be displayed in a label.

Procedure:

- Draw the appearance of the user controls with standard objects that are offered by WPF.
- Program the properties and interactions.
- Compile the complete package.

The result is available as a .NET assembly.

This assembly can be used for WPF projects. To do this, it must be referenced (linked) in the WPF editor (for example: Microsoft Expression Blend). To do this, select the assembly in the zenon file selection dialog:
From this point in time, the WPF user controls of the assembly in the tool box can be selected under **Custom user controls** and used in the WPF project. Read more about this in the **Guidelines for developers** (on page 24).

**USED REFERENCED ASSEMBLIES IN ZENON**

To use an assembly in zenon, this must be provided as a file. Collective files in `.cdwpf` format manage the assemblies independently. No further configuration is necessary. Assemblies must be added to the *Files* folder for `.xaml` files:

- Click on *Files* on the project tree.
- Select *Others*
- Select *Add file...* in the context menu
  The file selection dialog is opened.
- Insert the desired assembly

When displaying a WPF file in the **WPF element** (Editor and Runtime), the assemblies from this folder are loaded. It is thus also ensured that that when the Runtime files are transferred using **Remote Transport**, all referenced assemblies are present on the target computer.

A collective file (`.cdwpf`) can exist alongside an XAML file with the same name. All assemblies (`*.dll`) from all collective files and the *Other* folder are copied to the work folder. Only the highest file version is used if there are several assemblies with the same name.
**Hint**

DLLs that are part of a WPF element can also be replaced during ongoing operation. In doing so, the referencing is via linking in the XAML file.

To replace a DLL:
- Close all zenon screens in which the WPF element is used.
- Close all symbols that use a desired WPF element.
- In Explorer, replace the DLL in the `\wpfcache` folder of the Editor files. You can find this folder in the SQL directory under `...\PROJECT-GUID\FILES\zenon\custom\wpfcache`.

As an alternative to replacement using Explorer, you can also replace the file in the zenon Editor directly. To do this, carry out the following steps:
- In the Visual Studio project settings, increase the file version of the DLL.
- Create the new DLL.
- Close all zenon screens in which the WPF element is used.
- Close all symbols that use a desired WPF element.
- In the zenon Editor, delete the DLL from the `\Files\Other` folder and add the file with the higher version number.

**MULTI-PROJECT ADMINISTRATION**

With multi-project administration, the same assembly must be used in all projects. If an assembly is replaced by another version in a project, it must also be replaced in all other projects that are loaded in the Editor or in Runtime.

### 3.3 Workflows

The WPF/XAML technology makes new workflows in process visualization possible. The separation of design and functionality ensures a clear distinction of roles between the project engineer and designers; design tasks can be easily fulfilled by using pre-existing designs, which no longer need to be modified by the project engineer.

The following people are involved in the workflow to create WPF elements in zenon:
- Designer
  - illustrates elements
  - takes care of the graphics for MS Expression Design
- MS Expression Blend operator
Animates elements
Creates variables for the animation of WPF elements in zenon, which project engineer can access

Project engineer
Integrates elements into zenon:
stores logic and functionality

We make a distinction:
Workflow with Microsoft Expression Blend (on page 11)
Workflow with Adobe Illustrator (on page 11)

3.3.1 Workflow with Microsoft Expression Blend

When using Microsoft Expression Blend, a WPF element is created in four stages:
1. Illustration of elements in MS Expression Blend (on page 12)
2. Open element in MS Expression Design and export as WPF
3. Animation in MS Expression Blend (on page 12)
4. Integration into zenon (on page 117)

You can find an example for creating a WPF elements with Microsoft Expression Blend in the Create button as XAML file with Microsoft Expression Blend (on page 12) chapter.

3.3.2 Workflow with Adobe Illustrator

Based on traditional design processes with Adobe Illustrator the following workflow is available:
1. Illustration of elements in Adobe Illustrator (on page 16)
2. Import of .ai files and preparation in MS Expression Design (on page 18)
3. WPF export from MS Expression Design (on page 18)
4. Animation in MS Expression Blend (on page 20)
5. Integration into zenon (on page 112)

You can find an example for creation in the Workflow with Adobe Illustrator (on page 16) chapter.
4 Guidelines for designers

This section informs you how to correctly create WPF files in Microsoft Expression Blend and Adobe Illustrator. The tutorials on Creating a button element (on page 12) and a bar graph element (on page 16) show you how fully functional WPF files for zenon can be created from pre-existing graphics in a few steps.

The following tools were used for this:
- Adobe Illustrator CS3 (AI)
- Microsoft Expression Design 4 (ED)
- Microsoft Expression Blend 4 (EB)
- zenon

**Information**

If referenced objects (assemblies) are used in WPF, note the instructions in the Referenced objects (on page 8) chapter.

4.1 Workflow with Microsoft Expression Blend

With Microsoft Expression Blend, a WPF element:
- is illustrated
- is converted into WPF format using MS Expression Design
- animated

The following example shows the illustration and conversion of a button element into an XAML file.

**Note:** A test version of "Microsoft Expression Blend" can be downloaded from the Microsoft website.

4.1.1 Create button as an XAML file with Microsoft Expression Blend

**CREATE BUTTON**

1. Start Expression Blend
2. select the **New Project** option

3. Select **WPF** as project type

4. give it a path and name of your choice (MyBlendProject, for example)

The **Language** and **Version** settings can be ignored, because no functionality is to be programmed.

5. After the dialog has been confirmed with **OK**, Microsoft Blend creates a new project with the chosen settings. Expression Blend adds an empty XAML file which already contains a class reference.

6. Delete the CS file that belongs to the XAML file using the context menu.
7. Rename the XAML file `MainControl.xaml` to `MyButton.xaml`.

8. The development size of the file is set at 640 x 480 pixels as standard and must still be changed:
   a) switch to XAML view
   b) correct the size to 100 x 100 pixels
   c) Delete the class reference `x:Class="MyBlendProject.MyButton"`

9. switch to Design view

10. add a button via the toolbar

11. define the properties
    - Width: 50
    - Height: 50
Guidelines for designers

- Margins: 25

The button is therefore at the center of the control.

12. Save the changes and open the file in Internet Explorer to check it. You will see that the button is displayed in a size of 50 x 50 pixels.

MAKE BUTTON SCALABLE

If you integrate this status into zenon, the button will always have the exact size of 50 x 50 pixels. Because the button can be implemented as a scalable button, switch to Expression Blend again:

1. Select the button in the tree view.
2. select the Group Into -> Viewbox button in the context menu
3. the button is inserted into a Viewbox
4. Define the properties of the viewbox
   - Width: Auto
   - Height: Auto
5. save the file

6. If you now open the file in Internet Explorer, the button is automatically scaled when the IE window size is changed. This file will now also automatically adapt to changes in the size of the WPF element in zenon.

CHANGE NAME

Before you can integrate the file into zenon, you must give the WPF element a name. The WPF elements are not named in Expression Blend as standard, and are labeled with square brackets and their type. zenon content is assigned to WPF content via the name of the WPF elements:

- in tree view, change the name
  - of the button on MyButton
  - of the ViewBox to MyViewBox

This button can now be integrated in zenon (on page 117) as an XAML file.

4.2 Workflow with Adobe Illustrator

When Adobe Illustrator is used, a WPF element:

- is illustrated in Adobe Illustrator
- is converted into a WPF in MS Expression Design
- is animated in MS Expression Blend

The following example shows the illustration and conversion of a bar graph element into an XAML file.

4.2.1 Bar graph illustration

A bar graph is created in Adobe Illustrator.
1. **AI: Starting element for bar graph**

Illustrated in Adobe Illustrator CS3.

2. **AI: Path view of bar graph in Adobe Illustrator**

- All effects must be converted (**Object -> Convert appearance**)
- All lines are transformed into paths (**Object -> Path -> Contour line**)
- Do not use filters such as shading, blurring etc.

### NOTES ON COMPATIBILITY

Illustrations that were created with Adobe Illustrator are in principle suitable for WPF export. However, not all Illustrator effects can become corresponding effects in Expression Design/Blend. Note:

<table>
<thead>
<tr>
<th>Effect</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipping masks</td>
<td>Clipping masks created in Adobe Illustrator are not correctly interpreted by Expression Design. These are usually shown in Blend as areas of black color. We recommend creating illustrations without clipping masks.</td>
</tr>
<tr>
<td>Filters and effects</td>
<td>Not all Adobe Illustrator filters are transferred into Expression Design accordingly: Thus blurring filters, shading filters and corner effects from Illustrator do not work in Expression Design. Solution:</td>
</tr>
<tr>
<td></td>
<td>Most effects can be converted so that they can be read correctly by Expression Design using the <strong>Object -&gt; Convert appearance</strong> command in Adobe Illustrator.</td>
</tr>
<tr>
<td></td>
<td>Corner effects from Adobe Illustrator are correctly interpreted by MS Design if they are converted to AI in paths.</td>
</tr>
<tr>
<td>Text fields</td>
<td>To be able to link text fields with code, these must be created separately in Expression Blend. &quot;Labels&quot; are required for dynamic texts; simple &quot;text fields&quot; are sufficient for static information.</td>
</tr>
</tbody>
</table>
### Effect | Description
--- | ---
| There is no possibility to create text labels in MS Design. These must be directly created in MS Blend. | 
| **Transparencies and group transparencies** | There can be difficulties in Adobe Illustrator with the correct interpretation of transparency settings, in particular from group transparency settings.
However MS Expression Blend and MS Expression Design do offer the possibility to create new transparency settings. |
| **Multiply levels** | These level settings in Adobe Illustrator are not always correctly displayed by MS Expression Blend.
However, there is the possibility to "Multiply levels" directly in Expression Design. |
| **Indicating instruments and standard positions** | To prepare the graphics optimally for animation, the indicator and slider must always be set to the starting position, usually 0 or 12:00 o'clock.
Thus the position parameters for rotations etc. are also correct in Blend and an animation can be implemented without conversion of position data. |

### 4.2.2 WPF export

WPF files are required for animation in Microsoft Expression Blend. We recommend Microsoft Expression Design for this export, because it provides good results and most Illustrator effects are correctly interpreted.

**Note:** There is a free plug-in for the direct export of WPF files from Adobe Illustrator available on the internet. This plug-in provides a quick, uncomplicated way of exporting from Illustrator, however it is less suited to the current application because it lead to graphical losses. Even color deviations from the original document are possible.

Files in .ai format can regularly be imported into Expression Design; the paths are retained in the process.

**Attention:** Some common Illustrator effects cannot be displayed by Expression Design correctly however (see Illustration (on page 16) chapter).

We export the pre-created bar graph element in 5 stages:

1. **ED: Import**
1. Import the prepared Illustrator file (on page 16) in **Microsoft Expression Design** via File -> Import

2. **ED: Optimization**

   - If the starting file is not correctly displayed in MS Expression Design, it can still be subsequently edited and optimized here.

3. **ED: Select**

   - Highlight the element for WPF export with the *direct selection* arrow in MS Expression Design; in this case it is the whole clock.

4. **ED: Start export**

   - Start the export via File -> Export
   - The dialog for configuring the export settings opens.
5. **ED: Export settings**

   - Enter the following export settings:
     a) **Format**: XAML Silverlight 4 / WPF Canvas
     **Always name objects**: Activate with tick
     **Place the grouped object in an XAML layout container**: Activate with tick
     b) **Text**: Editable text block
     c) **Line effects**: Rasterize all

The exported file has .xaml file suffix. It is prepared and animated (on page 20) in MS Expression Blend in the next stage.

### 4.2.3 Animation in Blend

With MS Expression Blend:

- static XAML files from MS Expression Design are animated
- Variables for controlling effects that can be addressed by zenon are created

In thirteen steps, we go from a static XAML to an animated element, that can be embedded in zenon:

1. **EB: create project**

   - Open Microsoft Expression Blend
   - Create a new project
   - Select the **Project type** of WPF- > WPF Control Library
   - Give it a name (in our tutorial: **My_Project**)
   - Select a location where it is to be saved
   - Select a language (in our tutorial: C#)
   - Select a framework that is supported by zenon
2. **EB: delete MainControl.xaml.cs**

   a) Navigate to `MainControl.xaml.cs`  
   b) Delete this file using the **Delete** command in the context menu

3. **EB: Open exported XAML file**

   a) Open the context menu for **My_Project** (right mouse button)  
   b) Select **Add existing element...**  
   c) Select the XAML file exported from Microsoft Expression Design, in order to open this in Microsoft Expression Blend

4. **EB: Open MainControl.xaml**

   a) Open the automatically created **MainControl.xaml**  
   b) In the **Objects and Time axes** area, navigate to the **UserControl** entry

5. **EB: Adapt XAML code**

   a) Click on **UserControl** with the right mouse button  
   b) Select **Display XAML** in the contextual menu.  
   c) Delete lines 7 and 9 in the XAML code:
   ```xml
   x:Class="My_Project.MainControl"
   d:DesignHeight="480"
   ```
6. **EB: check XAML code**

   The XAML code should now look like this:

   ```xml
<UserControl
    xmlns=http://schemas.microsoft.com/winfx/2006/xaml/presentation
    xmlns:x=http://schemas.microsoft.com/winfx/2006/xaml
    mc:Ignorable="d"
    x:Name="UserControl">

    <Grid x:Name="LayoutRoot"/>

</UserControl>
```

7. **EB: Copy elements**

   a) Open the XAML file imported from Expression Design
   b) Mark all elements
   c) Select **Delete** in the context menu
   d) Change back to the automatically created XAML file

8. **EB: Insert element**

   a) Click on **Layout Root** with the right mouse button
   b) Select **Insert**
9. **EB: Adapt layout type**

   a) Click on **Layout root -> Change layout type -> Viewbox** with the right mouse button
   
   b) The structure should now look like this: **UserControl -> LayoutRoot -> Grid -> Elements**
   
   c) Assign a name for **LayoutRoot** and **Grid** by double-clicking on the names

10. **EB: Texts and values**

   ▶ Dynamic and static texts are labeled with text fields
   
   ▶ Values (numbers) are issued with **Labels**

11. **EB: Insert labels**

   ▶ Labels replace numbers that are to be subsequently linked using INT variables (must be carried out for all number elements)

12. **EB: Set property**

   ▶ To display 100%, set the bar graph element’s **MaxHeight** property to **341** (the maximum height of the indicator element is **340**)

13. **EB: prepare for use in zenon**

   a) Delete all name labels (names may only be given for elements that are to be addressed via zenon)
   
   b) Save the XAML file with any desired name
c) Integrate the XAML file into zenon (on page 112)

A hint for checking: If the XAML file is displayed with no problems in Microsoft Internet Explorer and the window size of Internet Explorer adapts to it, it will also be correctly used in zenon.

5 Guidelines for developers

This section handles the creation of simple WPF user controls with code-behind functionality using Microsoft Visual Studio and debugging this user control in the Runtime.

The following tools were used for this:
- Microsoft Visual Studio 2015
- zenon

Information

Recommendation: Use Microsoft Visual Studio version 2012 or later. The XAML designer is better integrated in this.

5.1 Creation of a simple WPF user control with code behind function

The creation and incorporation of a simple user control is described in this chapter. Because only the fundamental mechanisms/process for integration into zenon is described, the functionality of the user control is limited to the addition of two values. There is intentionally no enhanced error handling or explicit completion, in order to retain the simplicity of this example.

CREATE WPF USER CONTROL

1. Create a new Solution and a WPF User Control Library in this in Visual Studio.
   - The .NET framework version 4 was selected for this example. A different version can also be selected, which must be installed on the target system on which Runtime will subsequently be started.
   - Info: If the corresponding project template does not appear in the list of available templates, this can be added by means of the search (field at the top right of the dialog).
In our example, the project is given the name `WPFUserControlLibrary`.

2. Create 3 text boxes and a button in the `UserControl1.xaml` file:

3. Add the following code in the click event of the button:

```csharp
private void buttonAdd_Click(object sender, RoutedEventArgs e)
{
    try
    {
        textBox.Text = (Convert.ToInt32(textBoxA.Text) + Convert.ToInt32(textBoxB.Text)).ToString();
    }
    catch (Exception ex)
    {
        textBox.Text = "Error adding values: " + ex.Message;
    }
}
```
Now you have the user control with the required functionality available. However, because zenon can only display XAML files that do not link to a code-behind file, an additional XAML file is needed that references the library (assembly) that has just been built.

CREATION OF THE XAML FILE (WITHOUT CODE BEHIND) FOR ZENON

Proceed as follows to create the XAML file required in zenon.

1. Create a further project, again as a WPF User Control Library
2. It was called WPFUserControlNoCodeBehind in our example.
3. Insert a reference to the project that has just been built into this new project.

4. The XAML files (UserControl1.xaml) looks as follows:

```xml
<UserControl x:Class="WPFUserControlNoCodeBehind.UserControl1"
xmlns="http://schemas.microsoft.com/winfx/2006/xaml"
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
xmlns:local="clr-namespace:WPFUserControlNoCodeBehind"
x:Name="UserControl1"
mc:Ignorable="d"
d:DesignHeight="300" d:DesignWidth="300"
>
  <Grid>
    <Grid>
      <!-- Grid content -->
    </Grid>
  </Grid>
</UserControl>
```

5. Because all necessary content is contained in the DLL that has been created and no code-behind file can be used, delete the following lines:

   `x:Class="WPFUserControlNoCodeBehind.UserControl1"
   xmlns:local="clr-namespace:WPFUserControlNoCodeBehind"
   mc:Ignorable="d"
   d:DesignHeight="300" d:DesignWidth="300"
   `  

6. Also delete (for the designer’s size setting) the following lines:

   `mc:Ignorable="d"
   d:DesignHeight="300" d:DesignWidth="300"
   `  

7. Delete the code-behind file (UserControl1.xaml.cs) in this project.
8. Drag the user control that has been created beforehand (for the project WPFUserControlLibrary) over the toolbox in the XAML designer.

9. Assign a name for the grid and the user control.
   **Attention:** If no name is given here, these elements do not appear in the linking dialog in the zenon Editor and thus cannot be made dynamic.

10. The XAML file should now look as follows:

    ```xml
    <userControl xmlns="https://schemas.microsoft.com/winfy/2006/xaml/presentation"
                 xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
                 xmlns:local="http://schemas.openxmlformats.org/compatibility/2006">
        <Grid Name="MainGrid">
            <WPFUserControlLibrary:UserControl Name="AdditionControl" HorizontalAlignment="Left" VerticalAlignment="Top"/>
        </Grid>
    </userControl>
    ```

    In the next step, how the DLL and XAML file are incorporated into zenon is explained.

**STEPS IN ZENON**

1. Open the zenon Editor
2. Go to File -> Graphics.
3. Select Add file... in the context menu

4. Select the XAML file at the save location (*UserControl1.xaml* from the WPFUserControlNoCodeBehind project) and add this:

5. Insert the DLL with the functionality for the XAML file.
   To do this:
a) Select, in the context menu, File -> Other Add file....
b) Select the file WPFUserControlLibrary.dll (from the output path) of the first project (WPFUserControlLibrary).

6. Create a zenon screen.
7. Add a WPF element and select the previously-incorporated XAML file. You should now see the following in the zenon Editor:

8. Start zenon Runtime in order to also test the control there.

Information

The XAML file and referenced assemblies can also be saved in compiled form as a *.cdwpf file. Only one file thus need to be imported in the Editor (under Files -> Graphics). Further information on this can be found in the CDWPF files (collective files) (on page 48) chapter.

Hint: When developing a WPF user control, it is usually more practical to insert the XAML file and the referenced DLL(s) separately. This makes the replacement of the DLL and debugging easier. Further information on the topic of debugging can be found in the Debugging the WPF user control in the Runtime (on page 29) chapter.
### Hint

DLLs that are part of a WPF element can also be replaced during ongoing operation. In doing so, the referencing is via linking in the XAML file.

To replace a DLL:

- Close all zenon screens in which the WPF element is used.
- Close all symbols that use a desired WPF element.
- In Explorer, replace the DLL in the `\wpfache` folder of the Editor files. You can find this folder in the SQL directory under `...\PROJECT-GUID\FILES\zenon\custom\wpfcache`.

As an alternative to replacement using Explorer, you can also replace the file in the zenon Editor directly. To do this, carry out the following steps:

- In the Visual Studio project settings, increase the file version of the DLL.
- Create the new DLL.
- Close all zenon screens in which the WPF element is used.
- Close all symbols that use a desired WPF element.
- In the zenon Editor, delete the DLL from the `\Files\Other` folder and add the file with the higher version number.

Further examples can be found in the Examples: Integration of WPF into zenon (on page 112) chapter.

### 5.2 Debugging the WPF user control in the Runtime

To debug the WPF user control in the Runtime, proceed as follows.

In this example, the control described in the Creation of a simple WPF user controls with code behind function (on page 24) is used.

#### DEBUGGING BY MEANS OF ATTACH TO PROCESS

1. Ensure that zenon Runtime has been started and a screen with the WPF user control is open. Furthermore, ensure that the DLL that is currently being used corresponds to the build (Version) of the user control project (`WPFUserControlLibrary`).
2. Set a breakpoint in the click event of the button in the Visual Studio project.

```csharp
private void button1_Click(object sender, EventArgs e)
{
    try
    {
        textBox1.Text = Convert.ToInt32(textBox2.Text) + Convert.ToInt32(textBox3.Text); // Return the sum
    }
    catch (Exception ex)
    {
        textBox1.Text = "Error adding values: " + ex.Message;
    }
}
```

3. In Visual Studio, under **Debug**, select the **Attach to Process** menu item.

4. Select the zenon Runtime process.

5. Under **Attach to**, select either **Automatic** or the corresponding .NET framework version.

6. Click on **Attach**.
7. Now trigger the breakpoint in which you enter values into the WPF control in zenon Runtime and click on the button

```
private void buttonAdd_Click(object sender, RoutedEventArgs e)
{
    try
    {
        textBoxA.Text = (Convert.ToInt32(textBoxA.Text) + Convert.ToInt32(textBoxB.Text)).ToString();
        catch (Exception ex)
        {
            textBoxC.Text = "Error adding values: " + ex.Message;
        }
        textBoxC.Text = "Add Values"
    }
}
```

### DEBUG USING START EXTERNAL PROGRAM

1. Ensure that zenon Runtime has been closed.
2. Ensure that, in the zenon Editor, the project that contains the WPF user control has been set as the start project.
3. Ensure that the user control project (WPFUserControlLibrary) is set as the start project in Visual Studio.
4. In the project properties of the Visual Studio project, select under Debug, for Start action: Start external program.
5. For Start external program, select the path of the zenon Runtime application.
6. Under Working Directory, select the \wpfcache folder of the Runtime files (...\PROJECTNAME\RT\FILES\zenon\custom\wpfcache)
Hint: In the selected project in the zenon Editor, press the keyboard combination CTRL+ALT+R in order to jump directly to the root directory of the Runtime files.

7. In the project properties, enter `wpfache` folder of the Runtime files as the **Output path** under **Build**.

8. Create the project in Visual Studio.
9. Start debugging in Visual Studio with **Start**.

10. zenon Runtime is now started automatically.

11. Trigger the breakpoint by entering values in the WPF control in zenon Runtime and click on the button.
Information

When starting zenon Runtime, the assemblies (DLLs) referenced in the WPF user controls from the \FILES\zenon\custom\additional folder, and/or the assemblies from CDWPF files in the \FILES\zenon\custom\wpfcache folder are copied. If the file version of the DLL in the \wpfcache folder is one higher than the version of the "original file", it is not replaced!

For debugging, it is thus sufficient to only replace the file that is on the \wpfcache folder directly.

For delivery, it must be ensured that the current version of the DLL is present in the \additional folder or the CDWPF file!

Attention: If only the DLL is updated in the \additional folder or in the CDWPF, but the version number is not increased, the DLL must be deleted manually in the \wpfcache folder, because it is not updated otherwise (due to the above-described mechanism).

Hint

DLLs that are part of a WPF element can also be replaced during ongoing operation. In doing so, the referencing is via linking in the XAML file.

To replace a DLL:

- Close all zenon screens in which the WPF element is used.
- Close all symbols that use a desired WPF element.
- In Explorer, replace the DLL in the \wpfcache folder of the Editor files. You can find this folder in the SQL directory under ...
  \PROJECT-_GUID\FILES\zenon\custom\wpfcache

As an alternative to replacement using Explorer, you can also replace the file in the zenon Editor directly. To do this, carry out the following steps:

- In the Visual Studio project settings, increase the file version of the DLL.
- Create the new DLL.
- Close all zenon screens in which the WPF element is used.
- Close all symbols that use a desired WPF element.
- In the zenon Editor, delete the DLL from the \Files\Other folder and add the file with the higher version number.
5.3 Data exchange between zenon and WPF user controls

There are different possibilities for exchanging data between zenon and WPF user controls.

- Data exchange using dependency properties (on page 34)
- Data replacement via VSTA (on page 38)

5.3.1 Data exchange using dependency properties

The most elegant and secure way to exchange data between zenon and self-created WPF user controls is by using Dependency Properties.

The WPF user control project created in the Creating a simple WPF user controls with code behind function (on page 24) serves as a basis (WPFUserControlLibrary).

In this chapter, the focus is purely on the core theme (Dependency Properties and data exchange between the user control and zenon in this case). Specific WPF features such as Databinding, etc., as well as explicit error handling, are not covered.

ADDITIONS TO THE CODE

1. Create the TextChanged Event for the textBoxA element in the UserControl1.xaml file

   ```xml
   TextChanged="textBoxA_TextChanged"
   ```

2. Add the following lines of code in the UserControl1 class of the code behind file (UserControl1.xaml.cs)

   ```csharp
   /// <summary>
   /// Gets or sets the ValueA.
   /// </summary>
   public double ValueA
   {
   get
   {
   return (double)GetValue(ValueADependencyProperty);
   }
   set
   {
   SetValue(ValueADependencyProperty, value);
   }
   ```
/// <summary>
/// Dependency property for ValueA
/// </summary>
public static readonly DependencyProperty ValueADependencyProperty = DependencyProperty.Register("ValueA", typeof(double), typeof(UserControl1), new FrameworkPropertyMetadata(0.0, new PropertyChangedCallback(OnValueADependencyPropertyChanged)));

/// <summary>
/// Called when [value a dependency property changed].
/// </summary>
/// <param name="source">The source.</param>
/// <param name="e">The <see cref="DependencyPropertyChangedEventArgs"/> instance containing the event data.</param>
private static void OnValueADependencyPropertyChanged(DependencyObject source, DependencyPropertyChangedEventArgs e)
{
    UserControl1 control = source as UserControl1;
    if (control != null)
    {
        try
        {
            control.ValueA = (double)e.NewValue;
            controltextBoxA.Text = control.ValueA.ToString();
        }
        catch (Exception)
        {
        }
    }
}

/// <summary>
/// Handles the TextChanged event of the textBoxA control.
/// </summary>
/// <param name="sender">The source of the event.</param>
/// <param name="e">The <see cref="TextChangedEventArgs"/> instance containing the event data.</param>
private void textBoxA_TextChanged(object sender, TextChangedEventArgs e)
{
    try
    {
    }
ValueA = Convert.ToDouble(textBoxA.Text);
}
catch (Exception)
{
}

Then build the solution.

**Information**

A numerical property (double) is used in this example. Other simple data types (such as bool, string, int, etc.) can also be used.

**LINKING IN ZENON**

1. Update the WPF user control (DLL) in the zenon Editor.
2. Proceed as described in the creation of a simple WPF user controls with code behind function (on page 24) chapter.
3. Create a numeric variable in zenon. Link the variable to a dynamic text element.
   You place the dynamic text element in the screen next to the WPF element with your user control.
4. Open the screen that contains the WPF element.
5. Go to **Configuration** in the properties of the WPF element in the **WPF links** property group.
6. Expand the node in the tree view at the top left and select **AdditionControl**

7. Select the line with **ValueA** (this is the name of the property that was created in the code beforehand) and select, for **Type of link**: **Variable**.

   **Hint:** Give Properties a prefix so that this can be found more easily, for example: `_ValueA`

8. In the column under **Linkage**, print out the variable that was created in zenon beforehand

9. Confirm the dialog with OK and build the Runtime files
10. Start Runtime in order to test the WPF user control

11. If the value is changed in user control, the value automatically changes in zenon and vice versa.

12. You can of course debug the control as described in the Debugging the WPF user control in Runtime (on page 29) chapter, and create further dependency properties.

**Information**

The UserControl_Loaded event can be used in order to (automatically) access the values of the dependency property during initialization (when calling up the user control) for example.

### 5.3.2 Data replacement via VSTA

Data can also be exchanged between zenon and WPF user controls using VSTA.

The API element methods

- `get_WPFProperty` (reading of values)
- `set_WPFProperty` (writing of values)

are used for this.

The example used here is based on the example used in the Data exchange using dependency properties (on page 34) chapter.
CREATION OF A VSTA MACRO FOR DATA EXCHANGE BETWEEN ZENON AND THE WPF USER CONTROL

1. Create the following VSTA macro in the project add-in of the zenon project

```csharp
    /// Sample Macro for data exchange between VSTA and a WPF User Control
    ///
    public void MacroWPFAccess()
    {
        //Get the Screen and Element hosting the WPF User Control
        zenOn.IDynPicture myWPFScreen = this.DynPictures().Item("Screen");
        zenOn.IElement myWPFElement = myWPFScreen.Elements().Item("WPF_Element");

        //Read the current value from the WPF Element property
        double currentValue = Convert.ToDouble(myWPFElement.get_UFFProperty("AdditionControl", "ValueA");

        //Double the value and write it back to the WPF Element property
        myWPFElement.set_UFFProperty("AdditionControl", "ValueA", currentValue * 2);
    }
```

Whereby:
- "Screen" is the name of the zenon screen in which the WPF element is located
- "WPF_Element" is the name of the WPF element that contains the WPF user control
- "AdditionControl" is the name of the WPF user controls itself (defined in the UserControl1.xaml file)
- "ValueA" is the name of the user control property

2. Create an execute VSTA macro function and link this to a button in the screen in which the WPF element is also located

3. Start Runtime to test changes

When executing the macro, the value is read by the control, doubled and written back.

Information

The user control properties used for this method of data exchange need not necessarily be dependency properties, as outlined in this example. "Standard" properties can also be used, see in relation to this the Access via VSTA "variable link" (on page 40) chapter.
5.4 Access to the zenon (Runtime) object model from a WPF user control

There are different possibilities for access to the zenon object model from a WPF user control. This is explained in more detail in the following chapters.

⚠️ Attention

When using zenon COM objects with self-created user controls or external applications, they must be enabled using the `Marshal.ReleaseComObject` method. Enabling by means of the `Marshal.FinalReleaseComObject` method must not be used, because this leads to a malfunction of zenon Add-ins.

5.4.1 Access via VSTA "variable link"

In order to get access to the zenon Runtime COM interface by means of "variable link", proceed as follows. The creation of a simple WPF user controls with code behind function (on page 24) serves as an initial example.

💡 Information

The following code is intended to show an example of how the COM implements access to zenon Runtime and in doing so limits itself to the basic functionality. There is no explicit error handling, etc.

**NECESSARY AMENDMENTS IN WPF USER CONTROL**

The following steps are necessary in the WPF user control project (WPFUserControlLibrary).

Firstly, a reference to the zenon COM interface must be incorporated.
After this, the following code must be inserted in the `UserControl1` class:

```csharp
// The zenon Project
zenOn.Project zenonProject = null;

/// <summary>
/// Property for the Variable link via VSTA
/// </summary>
public object zenonVariableLink
{
    get { return null; }
    set {
        if (value != null && zenonProject == null)
        {
            zenOn.Variable zenonVariable;
            try
            {
                zenonVariable = (zenOn.Variable)value;
            }
            catch (Exception)
            {
                return;
            }
            if ((zenonVariable != null) && (!string.IsNullOrEmpty(zenonVariable.Name)))
            {
                zenonProject = zenonVariable.Parent.Parent;
            }
        }
    }
}

/// <summary>
/// Trigger used to notify the control from VSTA to release the COM resources
/// </summary>
public object zenonReleaseTrigger
{

get { return null; }
set {
  if (((bool)value && zenonProject != null)
  {
    try {
      Marshal.ReleaseComObject(zenonProject);
    }
    catch (Exception)
    {
      return;
    }
    zenonProject = null;
    GC.Collect();
    GC.WaitForPendingFinalizers();
    GC.Collect();
  }
}

Whereby access to the properties zenonVariableLink (to initialize the COM object) and zenonReleaseTrigger (to unlock the COM object) are subsequently accessed from VSTA (write).

In order to test the COM access quickly very easily, it is possible to insert the following line of code in the existing button click event of the user control.

```csharp
private void buttonAdd_Click(object sender, RoutedEventArgs e)
{
  if (zenonProject != null)
  {
    MessageBox.Show(zenonProject.Name);
  }
  return;
  ...
```
Information

A `zenOn.Project` variable is used in this example. Of course other objects such as events, etc. of the zenon object model can also be used.

NECESSARY AMENDMENTS IN THE ZENON PROJECT/VSTA CODE

The following steps are necessary in the VSTA code:

Creation of a VSTA macro for the initialization

```csharp
/// <summary>
/// Macro for API initialization in the WPF User Control
/// </summary>
public void MacroWPFInit()
{
    zenOn.IDynPicture myWPFScreen = this.DynPictures().Item("Screen");
    zenOn.IElement myWPFElement = myWPFScreen.Elements().Item("WPF_Element");
    myWPFElement.set_WPFProperty("AdditionControl", "zenonVariableLink", this.Variables().Item(0));
}
```

Creation of a VSTA macro for approval

```csharp
/// <summary>
/// Macro for API release in the WPF User Control
/// </summary>
public void MacroWPFRelease()
{
    zenOn.IDynPicture myWPFScreen = this.DynPictures().Item("Screen");
    zenOn.IElement myWPFElement = myWPFScreen.Elements().Item("WPF_Element");
    myWPFElement.set_WPFProperty("AdditionControl", "zenonReleaseTrigger", true);
}
```

Create two execute VSTA macro functions that are linked with buttons, which are in the same screen as the WPF element.

Now start Runtime in order to test the functionality

- Execute the macro for initialization
Guidelines for developers

- Click on the button in the WPF user control; a message box with the project name of the project appears

![User Control Example]

- Execute the macro for release

In order to debug the user control, it is possible to proceed as described in the Debugging the WPF user control in Runtime (on page 29).

**Hint**

The initialization and release of the COM object in this example is only carried out for simple demonstration using VSTA macro functions. Depending on the application, and/or in practice, events in VSTA are better suited to this.

For example, the code for initialization in the `_Open` event of the screen can be executed with the WPF element and the code for release in the `_Close` event.

The mechanism described here is also used in the Display of WPF elements in the zenon Web Client (on page 109) chapter.

**Attention**

If COM objects are used in WPF user controls, these must always be explicitly approved before destroying the WPF user control (before closing the screen, before closing Runtime, before reloading).

### 5.4.2 Access via marshaling

In order to get access to the zenon Runtime COM interface by means of marshaling, proceed as follows. The creation of a simple WPF user controls with code behind function (on page 24) serves as an initial example.
Information

The following code is intended to show an example of how the COM implements access to zenon Runtime and in doing so limits itself to the basic functionality. There is no explicit error handling, etc.

NECESSARY AMENDMENTS IN WPF USER CONTROL

The following steps are necessary in the WPF user control project (WPFUserControlLibrary).

Firstly, a reference to the zenon COM interface must be incorporated.

![Reference Manager - WPFUserControlLibrary](image)

After this, the following code must be inserted in the `UserControl1` class:

```csharp
//The zenon Project
zenOn.Project zenonProject = null;
```

Furthermore, the constructor of the user controls must be supplemented with the lines below (to initialize the COM object):

```csharp
/// <summary>
/// Constructor for UserControl1, initialize COM Object
/// </summary>
public UserControl1()
{
    InitializeComponent();

    try
    {
```
}
catch (Exception)
{
}

The COM object must be approved in the UserControl_Unloaded event:

/// <summary>
/// Release COM Object
/// </summary>
private void UserControl_Unloaded(object sender, RoutedEventArgs e)
{
try
{
if (zenonProject != null)
{
Marshal.ReleaseComObject(zenonProject);
zenonProject = null;
}
}
catch (Exception)
{
}

In order to test the COM access quickly very easily, it is possible to insert the following line of code in the existing button click event of the user control.

private void buttonAdd_Click(object sender, RoutedEventArgs e)
{
if (zenonProject != null)
{
MessageBox.Show(zenonProject.Name);
}
return;

...
Now build the solution and update the WPF user control in the zenon project.

Start Runtime to test the user control.

In order to debug the user control, it is possible to proceed as described in the Debugging the WPF user control in Runtime (on page 29).

**Information**

A `zenOn.Project` variable is used in this example. Of course other objects such as events, etc. of the zenon object model can also be used.

**Attention**

If COM objects are used in WPF user controls, these must always be explicitly approved before destroying the WPF user control (before closing the screen, before closing Runtime, before reloading).

**Information**

No access by means of marshaling is possible in the zenon web client. If access to the COM interface is required there, the method described in the Access via VSTA "variable link" (on page 40) must be used.
6 Engineering in zenon

In order to be able to use WPF user controls in zenon, version 4.6.2 (or higher, depending on the .NET framework version used in the user control) of the Microsoft framework must be used on both the Editor computer and the Runtime computer.

CONDITIONS FOR THE WPF DISPLAY IN ZENON

The dynamization is currently available for simple variable types (numerical data types as well as string). Arrays and structures cannot be dynamized.

Therefore the following WPF functions can be implemented in zenon:

- Element properties that correspond to simple data types, such as String, Int, Double, Bool etc.
- Element properties of the "Object" type, which can be set with simple data types
- Element events can be used with functions; the parameters of the events are not however available in and cannot be evaluated in zenon
- Element transformation, for which a RenderTransform is present for the element in the XAML file

Attention: if the content is outside of the area of the WPF element during transformation, this is not labeled

Notes on dBase: No shade can be displayed in zenon for WPF elements.

Attention

If the Runtime files were created for a project for a version before 6.50, existing WPF elements are not included into Runtime screens.

6.1 CDWPF files (collective files)

A CDWPF file (with the suffix *.cdwpf) is a renamed ZIP file that contains the following components:

- XAML file (to reference the user control assembly)
- DLL file (the actual WPF user control, optional)
- Preview graphics (for preview, optional)

Rules for the use of collective files:

- The files (XAML, DLL, preview graphics) can be in the CDWPF file directly or in a joint folder.
- The name of the collective file should correspond to the names of the XAML file.
Only one XAML file may be contained.

The preview graphic should be small and no more than 64 pixels high. Name of the preview file: `preview.png` or the name of the XAML file with the suffix `.png`.

Any number of assemblies can be used. The distinction is made on the basis of the file version.

Collective files do not need to contain an assembly.

All subfolders are examined and only taken into account with *.dll, *.xaml or *.png files.

If a collective file (*.cdwpf) is replaced by a file with a different version, all corresponding CDWPF files in all symbols and images in all projects must be adapted.

### 6.2 create WPF element

To create a WPF element

1. In the elements toolbar, select the symbol for **WPF element** or the **Elements** entry in the menu
2. Select the start point in the main window.
3. Pull open the element with the mouse.
4. In properties, select **Representation** the property **XAML file** in the group.
5. The file selection dialog opens.
6. Select the desired file
   Files of the following formats are valid:
   - *.xaml: Extensible Application Markup Language
   - *.cdwpf: WPF collective file, also shows preview image
   (The file must already be present in the Project Manager under **Files/graphics** or created in the dialog.)
7. Configure the links (on page 49).

**Information**

If referenced assemblies are used, note the instructions in the Referenced assemblies (on page 8) chapter.

### 6.3 Configuration of the linking

To configure a WPF element

1. In properties, select **WPF links** the property **Configuration** in the group.
2. The dialog with three tabs opens with a preview of the XAML file and the elements present in the file

**DIALOG CONFIGURATION**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available elements</td>
<td>Shows the named file elements in a tree structure. The selected element can be linked with process data.</td>
</tr>
<tr>
<td></td>
<td><strong>WPF</strong> is assigned to process data based on the element name. Therefore elements are only shown if they and the attendant elements have a name. Allocations are configured and shown in the <strong>Properties, Events, Transformations</strong> tabs.</td>
</tr>
<tr>
<td></td>
<td><strong>Hint:</strong> If the corresponding elements are not displayed, check whether the non-displayed objects in the XAML file have been given a name (for example: <code>&lt;Grid Name=&quot;GridName&quot;&gt;</code>).</td>
</tr>
<tr>
<td>Preview</td>
<td>The selected element is shown flashing in the preview.</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong> (on page 52)</td>
<td>Configuration and display of properties (variables, authorizations, interlockings, linked values).</td>
</tr>
<tr>
<td><strong>Events</strong> (on page 58)</td>
<td>Configuration and display of events (functions).</td>
</tr>
<tr>
<td><strong>Transformations</strong> (on page 59)</td>
<td>Configuration and display of transformations.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the property.</td>
</tr>
<tr>
<td>Linkage</td>
<td>Selection of link.</td>
</tr>
<tr>
<td>Type of link</td>
<td>Type of link (variable, authorization, function)</td>
</tr>
<tr>
<td>WPF info</td>
<td>Shows the current value for properties in WPF content. For the user, it is directly visible what type of property it is (Boolean, string, etc.).</td>
</tr>
<tr>
<td>Linked</td>
<td>Shows if a property is currently being used. If not contained in the view, can be selected via Context menu -&gt; Column selection.</td>
</tr>
</tbody>
</table>

### Information

Only logical objects can be displayed in the configuration dialog. Visual objects are not displayed. You can read background information and how visual objects can be animated in the Allocation of zenon object to WPF content.

### EDIT HYPERLINKS

All configured hyperlinks can be edited from the properties of the element. Click on the element and open the property group **WPF links**. Hyperlinks can be further configured here, without having to open the dialog.

Limitations:

- The linking type cannot be changed here.
- New linkings can only be created via the configuration dialog.
- Insertion of a WPF elements into a symbol: WPF linkings cannot be exported.
6.3.1 Properties

The properties enable the linking of:

- Variables (on page 53)
- Values (on page 55)
- Authorizations and interlockings (on page 56)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the property.</td>
</tr>
<tr>
<td>Linkage</td>
<td>Linked variable, authorization or linked value.</td>
</tr>
<tr>
<td></td>
<td>Clicking in the column opens the respective selection dialog, depending on the entry in the Link type column.</td>
</tr>
<tr>
<td>Type of link</td>
<td>Selection of linking.</td>
</tr>
<tr>
<td>WPF info</td>
<td>Shows the current value for properties in WPF content. For the user, it is directly visible what type of property it is (Boolean, string, etc.).</td>
</tr>
<tr>
<td>Linked</td>
<td>Shows if a property is currently being used.</td>
</tr>
<tr>
<td></td>
<td>If not contained in the view, can be selected via</td>
</tr>
</tbody>
</table>
CREATE LINK

To create a link:

1. Highlight the line with the property that is to be linked
2. Click in the **Link type cell**
3. Select the desired link from the drop-down list.
   The following are available:
   - `<not linked>` (deletes an existing link)
   - Authorization/Interlocking
   - Constant value
   - variable
4. Click in the **Link** cell
5. The dialog for configuring the desired link opens

**Information**

Properties of WPF and zenon can be different. If, for example the **visibility** property is linked, there are three values available in .NET:

- 0 - visible
- 1 - invisible
- 2 - collapsed

These values must be displayed via the linked zenon variable.

### 6.3.1.1 Link variable

To link a variable with a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the **Link type cell**
3. Select from the **variable** drop down list
4. Click in the **Link** cell
5. The dialog for configuring the variables opens
This dialog also applies for the selection of variables with transformations (on page 59). The configuration also makes it possible to convert from zenon into WPF units.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked variable</td>
<td>Selection of the variable to be linked. A click on the ... button opens the selection dialog.</td>
</tr>
<tr>
<td>Range of values of the WPF element</td>
<td>Data to convert variable values into WPF values.</td>
</tr>
<tr>
<td>Convert range of values</td>
<td><strong>Active</strong>: WPF unit conversion is switched on.</td>
</tr>
<tr>
<td></td>
<td><strong>Effect in the Runtime</strong>: The current zenon value (incl. zenon unit) is converted to the WPF range using standardized minimum and maximum values.</td>
</tr>
<tr>
<td></td>
<td><strong>For example</strong>: The value of a variable varies from 100 to 200. With the variables, the standardized range is set to 100 - 200. The aim is to display this change in value using a WPF rotary knob. For this:</td>
</tr>
<tr>
<td></td>
<td>‣ for <strong>Transformations</strong>, the <strong>RotateTransform.Angle</strong> property is linked to the variables</td>
</tr>
<tr>
<td></td>
<td>‣ <strong>Adjust value</strong> activated</td>
</tr>
<tr>
<td></td>
<td>‣ a WPF value range of 0 to 360 is configured</td>
</tr>
<tr>
<td>Minimum</td>
<td>Defines the lowest WPF value.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Defines the highest WPF value.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts settings and ends the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards settings and ends the dialog.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens online help.</td>
</tr>
</tbody>
</table>
### 6.3.1.2 Link values

Linked values can either be a **String** or a numerical value of the type **Double**. When selecting the screen, the selected value is sent in WPF content after loading the WPF content.

To link a value to a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the **Link type cell**
3. Select **Value linkings** from the drop-down list
4. Click in the **Link** cell
5. The dialog for configuration of value linking opens

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Linked value:</strong></td>
<td>Entry of a numerical value or string value.</td>
</tr>
<tr>
<td><strong>Use string</strong></td>
<td><strong>Active</strong>: A string value is used instead of a numerical value.</td>
</tr>
<tr>
<td></td>
<td>The language of string values can be switched. The text is translated in the Runtime when the screen is called up and sent in WPF content. If the language is switched whilst the screen is opened, the string value is retranslated and sent.</td>
</tr>
<tr>
<td><strong>String value/numerical value</strong></td>
<td>Depending on what is selected for the <strong>Use string</strong> property, a numerical value or a string value is entered into this field. A unit of measurement can also be selected for numerical values.</td>
</tr>
<tr>
<td><strong>Unit:</strong></td>
<td>Selection of a unit of measurement from the drop down list. You must have configured this in unit switching beforehand.</td>
</tr>
<tr>
<td></td>
<td>The unit of measurement is allocated with the numerical value. If the units are switched in the Runtime, the value is converted to the new unit of measurement and sent to WPF content.</td>
</tr>
</tbody>
</table>
CLOSE DIALOG

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Applies settings and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards all changes and closes the dialog.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens online help.</td>
</tr>
</tbody>
</table>

6.3.1.3 Link authorization or interlocking

Authorizations cannot be granted for the whole WPF element. The element is allocated a user level. Authorizations are granted within the user level for individual controls. If an authorization is active, the value 1 is written to the element.

To link a user authorization or interlocking to a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the Link type cell
3. Select Authorization/interlocking from the drop down menu
4. Click in the Link cell
5. The dialog for configuring the authorizations opens

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link authorization/interlocking</td>
<td>Setting the authorizations.</td>
</tr>
<tr>
<td>Linked status</td>
<td>Selection of an authorization that is linked to a WPF control from the drop down list. For example, visibility and operability of a WPF button can depend on a user’s status.</td>
</tr>
<tr>
<td>Authorization</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Operating authorization available</td>
<td>If the user has sufficient rights to operate the <strong>WPF element</strong>, a value of 1 is written to the property.</td>
</tr>
<tr>
<td>Operating authorization does not exist</td>
<td>If the user does not have sufficient rights to operate the <strong>WPF element</strong>, a value of 1 is written to the property.</td>
</tr>
<tr>
<td>Not interlocked</td>
<td>If the element is not locked, the value 1 is written to the property.</td>
</tr>
<tr>
<td>Interlocked</td>
<td>If the element is locked, the value 1 is written to the property.</td>
</tr>
<tr>
<td>Can be operated</td>
<td>If authorization is present and the element is not locked, then a value of 1 is written to the property.</td>
</tr>
<tr>
<td>Cannot be operated</td>
<td>If authorization is not present or the element is not locked, then a value of 1 is written to the property.</td>
</tr>
</tbody>
</table>
6.3.2 Events

Events make it possible to link zenon functions to a WPF element.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the property.</td>
</tr>
<tr>
<td>Linkage</td>
<td>Linked function. Clicking in the cell opens the configuration dialog.</td>
</tr>
<tr>
<td>Type of link</td>
<td>Selection of linking. Clicking in the cell opens the selection dialog.</td>
</tr>
<tr>
<td>WPF info</td>
<td>Shows the current value for properties in WPF content. For the user, it is directly visible what type of property it is (Boolean, string, etc.).</td>
</tr>
<tr>
<td>Linked</td>
<td>Shows if a property is currently being used. If not contained in the view, can be selected via Context menu -&gt; Column selection.</td>
</tr>
</tbody>
</table>

LINK FUNCTIONS

To create a link:
1. Highlight the line with the property that is to be linked
2. Click in the Link type cell
3. Select from the drop down list function
4. Click in the Link cell
5. The dialog for configuring the function opens

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked function</td>
<td>Selection of the function to be linked. Clicking on the ... button opens the dialog for Function selection.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts selection and closes dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards changes and closes dialog.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens online help.</td>
</tr>
</tbody>
</table>

### 6.3.3 Transformation

The WPF element does not support rotation. If, for example, the WPF element is in a symbol and the symbol is rotated, the WPF element does not rotate with it. Therefore there is a different mechanism for Transformation with WPF to turn elements or to otherwise transform them. These transformations are configured in the Transformation tab.
**Attention:** If the content is outside of the **WPF element** area, this part of the contents is lost or it is not shown.

---

**Parameter** | **Description**
---|---
**Name** | Name of the property.

**Linkage** | Selection of the linked variables.

Transformations are displayed in XAML as transformation objects with their own properties. If an element supports a transformation, then the possible properties of the transformation object are displayed in list view. (more on this in: Integrate button as WPF XAML in zenon (on page 117))

For example, if the linked variable is set at the value of 10, then this value is written as a WPF target and the WPF element is rotated by 10°.

**Type of link** | Selection of transformation link type.

**WPF info** | Shows the current value for properties in WPF content. For the user, it is directly visible what type of property it is (Boolean, string, etc.).

**Linked** | Shows if a property is currently being used.

If not contained in the view, can be selected via **Context menu->Column selection**.
LINK TRANSFORMATIONS

To link a transformation with a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the Link type cell
3. Select from the Transformation drop down list
4. Click in the Link cell
5. The dialog for configuring the variables opens

The configuration also makes it possible to convert from zenon into WPF units.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked variable</td>
<td>Selection of the variable to be linked. A click on the ... button opens the selection dialog.</td>
</tr>
<tr>
<td>Range of values of the WPF element</td>
<td>Data to convert variable values into WPF values.</td>
</tr>
<tr>
<td>Convert range of values</td>
<td><strong>Active</strong>: WPF unit conversion is switched on.</td>
</tr>
</tbody>
</table>

  **Effect in the Runtime**: The current zenon value (incl. zenon unit) is converted to the WPF range using standardized minimum and maximum values.

  **For example**: The value of a variable varies from 100 to 200. With the variables, the standardized range is set to 100 - 200. The aim is to display this change in value using a WPF rotary knob. For this:

  1. for **Transformations**, the **RotateTransform.Angle** property is linked to the variables
  2. **Adjust value** activated
  3. a WPF value range of 0 to 360 is configured

Now the rotary knob can be turned at a value of...
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum</td>
<td>Defines the lowest WPF value.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Defines the highest WPF value.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts settings and ends the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards settings and ends the dialog.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens online help.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>

#### 6.4 Validity of XAML Files

XAML files are valid subject to certain requirements:

- Correct name spaces
- No class references
- Scalability

**CORRECT NAME SPACE**

The **WPF element** can only display WPF content, i.e.:

Only XAML files with the correct WPF namespace can be displayed by the **WPF element**. Files that use a Silverlight namespace cannot be loaded or displayed. However, in most cases it is suffice to change the Silverlight namespace to the WPF namespace.

WPF-Namespace:

```xml
xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
```

**NO USE OF CLASS REFERENCES**

Because the XAML files can be loaded dynamically, it is not possible to use XAML files that contain references to classes ("class" key in header). Functions that have been programmed in independently-created C#-files cannot be used.

In order to use WPF user controls with code behind, the process as described in the Creating a simple WPF user control with code behind function (on page 24) must be carried out.
SCALABILITY

If the content of a **WPF element** is adjusted to the size of the **WPF element**, then the controls of the **WPF element** are interlaced in a control that offers this functionality, such as a **view box** for example. In addition, it must be ensured that the **height** and **width** for this elements are configured as **automatic**.

CHECKING AN XAML FILE TO SEE IF IT IS CORRECT

To check if an XAML file has the correct format:

- Open XAML file in Internet Explorer
  - If it can be opened without additional plug-ins (Java or similar), then it can be assumed with a high degree of certainty that this file can be loaded or displayed by zenon
  - if problems occur during loading, these are then shown in Internet Explorer and the lines in which problems arise can be clearly seen

The scaling can also be tested in this manner: If the file has been created correctly, the content will adjust to the size of the Internet Explorer window.

ERROR MESSAGE

If an invalid file is used in zenon, then an error message is displayed in the output window when loading the file in the WPF element.

For example:

`error when loading xaml-Datei:C:\ProgramData\COPA-DATA\SQL\781b1352-59d0-437e-a173-08563c3142e9\FILES\zenon \custom\media\UserControl1.xaml

The attribute "Class" cannot be found in XML namespace

6.5 Pre-built elements


zenon is already shipped with several WPF elements. More are available for download in the web shop.

All WPF elements have properties which determine the graphical design of the respective element (Dependency Properties). Setting the values via an XAML file or linking the property via zenon can directly change the look in the Runtime. The tables in the description of the individual elements contain the respective Dependency Properties, depending on the control.
Available elements:

- Analog clock (on page 64)
- Vertical bar graph (on page 65)
- BACnet WPF Control
- Comtrade Viewer (on page 66)
- Energy class diagram (on page 79)
- Progress bar (on page 66)
- Pareto diagram (on page 80)
- Sankey Diagram (on page 87)
- Round display (on page 83)
- Temperature control (on page 88)
- Universal slider (on page 89)
- Waterfall chart (on page 91)

REPLACING ASSEMBLY WITH A NEWER VERSION

Per project only one Assembly for a WPF element can be used in the zenon Editor as well as in the Runtime. If two versions of an Assembly are available in a project, then the first loaded file is used. A user enquiry is made as to which version should be used. No further actions are needed for the maintenance of the versions used up until now. If a newer version is chosen, all corresponding CDWPF files in all symbols and images in all projects must be adapted.

Note for Multi-Project Administration: If an Assembly in a project is replaced by a new version, it must also be replaced in all other projects that are loaded in the Editor or in Runtime.

6.5.1 Analog clock - AnalogClockControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ElementStyle</td>
<td>Shape/type of element.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ SmallNumbers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ BigNumbers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ No</td>
</tr>
<tr>
<td>ElementBackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementGlasReflection</td>
<td>Activate the glass effect on</td>
<td>Visibility</td>
</tr>
<tr>
<td></td>
<td>the element.</td>
<td></td>
</tr>
</tbody>
</table>
### Property | Function | Value
--- | --- | ---
Offset | Value in hours (h) which displays the time lag to the system clock. | Int16
OriginText | Text which is displayed in the clock (e.g. location). | String

#### 6.5.2 Bar graph vertical - VerticalBargraphControl

| Property | Function | Value |
--- | --- | --- |
CurrentValue | Current value which should be displayed. | Double |
MinValue | Minimum value of the scale. | Double |
MaxValue | Maximum value of the scale. | Double |
MajorTicksCount | Number of main ticks on the scale. | Integer |
MinorTicksCount | Number of sub ticks on the scale. | Integer |
MajorTickColor | Color of main ticks on the scale. | Color |
MinorTickColor | Color of sub ticks on the scale. | Color |
ElementBorderBrush | Color of the element border. | Brush |
ElementBackgroundBrush | Color of element background. | Brush |
ElementGlasReflection | Activate the glass effect on the element. | Visibility |
ElementFontFamily | Element font. | Font |
ScaleFontSize | Font size of the scale. | Double |
ScaleFontColor | Font color of the scale. | Color |
IndicatorBrush | Bar graph fill color. | Brush |
BargraphSeparation | Number of bar graph division. | Integer |
BargraphSeparationColor | Color of the scale division. | Color |
6.5.3 Progress bar - ProgressBarControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentValue</td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td>MinValue</td>
<td>Minimum value of the value area.</td>
<td>Double</td>
</tr>
<tr>
<td>MaxValue</td>
<td>Maximum value of the value area.</td>
<td>Double</td>
</tr>
<tr>
<td>ProgressBarDivisionCount</td>
<td>Number of divisions of the progress bar.</td>
<td>Integer</td>
</tr>
<tr>
<td>VisibilityText</td>
<td>Visibility of the value display.</td>
<td>Boolean</td>
</tr>
<tr>
<td>TextSize</td>
<td>Font size of the value display.</td>
<td>Double</td>
</tr>
<tr>
<td>TextColor</td>
<td>Color of the value display.</td>
<td>Color</td>
</tr>
<tr>
<td>ProgressBarBoxedColor</td>
<td>Color of the border of the progress bar.</td>
<td>Color</td>
</tr>
<tr>
<td>ProgressBarMarginDistance</td>
<td>Distance of the progress bar box from the element edge (left, top, right, down).</td>
<td>Double</td>
</tr>
<tr>
<td>ProgressBarInactiveBrush</td>
<td>Indicator color not active.</td>
<td>Brush</td>
</tr>
<tr>
<td>ProgressBarActiveBrush</td>
<td>Indicator color active.</td>
<td>Brush</td>
</tr>
<tr>
<td>ProgressBarPadding</td>
<td>Distance of the progress bar from the progress bar box (left, top, right, down).</td>
<td>Double</td>
</tr>
<tr>
<td>ElementBorderBrush</td>
<td>Color of the element border.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementBackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
</tbody>
</table>

6.5.4 COMTRADE-Viewer

The **COMTRADE-Viewer** WPF element is available to partners of COPA-DATA and is available to them via the COPA-DATA Partner Community ([https://www.copadata.com/en-us/partner-community/](https://www.copadata.com/en-us/partner-community/)).

License information

The **COMTRADE-Viewer** can only be configured in the zenon Editor with a valid Energy Edition license. If there is no valid license, the WPF is displayed as grayed out in the Editor. A valid Energy Edition license is also required for display in the Runtime.
The control supports the graphical analysis of digital error and event data logging of a COMTRADE file.

**Information**

The control supports IEEE C37.111 (IEEE Standard Common Format for Transient Data Exchange (COMTRADE) for Power Systems) standards-compliant files. ASCII or binary files in accordance with the 1999 or 2013 edition can be visualized.

Older files or files without a year identification are not supported. A warning dialog is called up when an invalid/unsupported file is selected.

Possibilities of the COMTRADE-Viewer WPF control in zenon Runtime:

- Selection of a file in the COMTRADE file format
- Visualization of the selected COMTRADE file:
  - **Note:** The display colors can be configured in the zenon Editor.
  - Current (sinus wave display)
  - Voltage (sinus wave display)
  - Digital signals (binary bar chart display)
  - Display of values at a selected cursor position.
  - If an element that represents neither current or voltage is selected, (such as frequency), this is visualized in both analog areas again (current and voltage).
- Navigation:
Zoom in and zoom out using the mouse wheel, scroll bar and Multi-Touch gestures
- Enlargement of the area
  Selection of the area by clicking the mouse
- Move the display area using the right mouse button, scroll bar or Multi-Touch gestures.
- Exports selected objects as an CSV file.

**Hint**
To be able to transport COMTRADE files to the zenon Runtime computer, you can also use the file transfer of the IEC 61850 driver or the FTP function block of zenon Logic.

You can find further information about this in the driver documentation of the IEC 61850 driver or in the zenon Logic documentation.

### 6.5.4.1 View in Runtime

The COMTRADE WPF element offers two views in the Runtime:
- Configuration view
  - Selection of a COMTRADE configuration file
  - Selection of the elements to be displayed
- Graph view
  - Zoom in and zoom out
  - Display of values at a selected cursor position.
  - Export of the selected elements as an CSV file

**Information**
The switch between the views is integrated in the WPF element. Additional project configuration of a screen switching function is not necessary.

### 6.5.4.2 Installation

Requirements:
- You must be a registered COPA-DATA Partner.
- You need to have access to the COPA-DATA Partner Community already granted.
TO DOWNLOAD A WPF ELEMENT:

2. Log in in the area called MY AREA.
3. Enter "Partner" as a search term by the microscope.
   COPA-DATA Partner Community appears with a link in the results.
4. Click on the link.
5. In the Partner Login Area, click on MORE.
   The Overview tab is opened.
6. Switch to the Documents & Downloads tab.
7. Under SELECT CATEGORY, activate the WPF element checkbox.
8. Click on Search.
   The labeling is hidden.
   An orange frame surrounds the search field.
9. Click in the frame and enter COMTRADE.
10. The COMTRADE Viewer is shown.
11. Under Actions, click on the orange symbol to download the COMTRADE Viewer.
12. Save the folder locally.
13. Unzip the file.
14. Open the COMTRADE folder that contains the Comtrade.cdwpf file.

6.5.4.3 Installation

To create a WPF element

1. Open the zenon Editor
2. In the project manager, go to Files and Graphics.
3. Go to Import file....
4. Select the file Comtrade.cdwpf for importing.
5. Confirm the selection by clicking on Open.
6. Open the screen in which the WPF element is to be inserted.
7. In the vertical menu bar, select the WPF element (WPF).
8. Drag the WPF element in the screen with the left mouse button.
   The File selection window is opened.
9. Select the file Comtrade.cdwpf and confirm the input by clicking on OK.
The WPF element is added.

6.5.4.4 Configurable control properties - color display

ENGINEERING IN THE EDITOR

The element with the name COMTRADE.CDWPF can be configured and placed in each zenon screen type.
The project configuration of Width [pixels] and Height [pixels] of the element depend on the proportions. This prevents the COMTRADE-Viewer being displayed as distorted in Runtime.

Note: When configuring the project, ensure that there is sufficient size to guarantee a clear overview.

GRAPHICAL AMENDMENTS

You configure the graphic design in the properties of the WPF element.
You can find further information in the configuration of the linking (on page 49) chapter in this manual.

Possible color values:

- Hexadecimal color values in the following formats can be used: #RRGGBB and #AARRGGBB
  Transparency values are permitted.
- **Example color values:**
  #000000 = black
  #FFFFFF = white
  #FF0000 = red
- Color values by name

**Hint**

The properties for the COMTRADE-Viewer WPF element have a "z" as a starting color. Use name filtering for a clear display when configuring the linking.

CONFIGURATION PAGE

Text and background color of the configuration page.
### parameter  
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>zConfigurationPageTextColor</code></td>
<td>Text color of the configuration page</td>
<td>String</td>
</tr>
<tr>
<td><code>zConfigurationPageBackgroundColor</code></td>
<td>Background color of the configuration page</td>
<td>String</td>
</tr>
</tbody>
</table>

### BUTTONS

Text and background color of the button.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>zButtonTextColor</code></td>
<td>Text color of the button</td>
<td>String</td>
</tr>
<tr>
<td><code>zButtonBackgroundColor</code></td>
<td>Background color of the button</td>
<td>String</td>
</tr>
</tbody>
</table>

### CHART

Text color of the axis labeling or key and background color.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>zChartTextColor</code></td>
<td>Text color of the axis labeling.</td>
<td>String</td>
</tr>
<tr>
<td><code>zChartBackgroundColor</code></td>
<td>Background color of the axis labeling</td>
<td>String</td>
</tr>
</tbody>
</table>

### LABEL

Text and background color of the display of a selected cursor position.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>zChartLabelTextColor</code></td>
<td>Text color of the value display</td>
<td>String</td>
</tr>
<tr>
<td><code>zChartLabelBackgroundColor</code></td>
<td>Background color of the value display</td>
<td>String</td>
</tr>
</tbody>
</table>
CHART

Color palette of the graph view and the attendant keys.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>zChartPalette</td>
<td>Color palette of the colors for graphs and keys.</td>
<td>String</td>
</tr>
<tr>
<td></td>
<td>Referencing with color palette name (see overview).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default: if no color palette is configured, the color palette of the computer's operating system is used.</td>
<td></td>
</tr>
</tbody>
</table>

POSSIBLE COLOR PALETTES - OVERVIEW

6.5.4.5 Configurable control properties - language and display settings

You can define the following using the following settings:

- Whether the standard dialog or a user-defined dialog should be used to open Windows files.
- Whether the user interface is to be displayed in Polish.
- Whether the CSV Export button is to be displayed in the Runtime.

<p>| Parameter       | Description                                                                 |
|-----------------|-----------------------------------------------------------------------------|-------|
| zLimitFileOpenAccessTo | If the parameter for another value is set to empty, a user-defined file opening dialog to open |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows files is opened. This dialog shows all *.CFG files for which a corresponding *.DAT files exists in the folder through which the parameter is addressed. Default: empty</td>
</tr>
</tbody>
</table>
| zUiLanguage                | If the parameter is set to one of the following values, the COMTRADE-Viewer user interface and the user-defined file opening dialog are displayed in Polish:  
                          |  - pl  
                          |  - pL  
                          |  - Pl  
                          |  - PL  
                          | Note: With the standard dialog, only the title is displayed in Polish to open files. The other entries relate to the Windows language settings. Default: en |
| zButtonCSVExportVisibility | Defines the display of the CSV Export button in the Runtime:  
                          |  - True: Button is displayed  
                          |  - False: Button is not displayed  
                          | Default: True                                                                                                            |
**Note:** This also applies if, in zenon Runtime, there is a switch from one screen to another screen with the screen switching function.

**COMTRADE VIEWER CONFIGURATION**

The **COMTRADE Viewer Configuration** switching, arranged vertically on the side, switches the display of the configuration to graphic view and vice versa.

**SELECT FILE**

The **Open...** button opens the file selection dialog to select a file.

There is a pre-selection for display in the file selection:

- In doing so, file pairs of *.cfg* and *.dat files are detected.
  
  **Note:** Optional *hdr* or *inf* files are not taken into account.

- Only the corresponding *.dat files are displayed.

- All attendant files (*.dat, *.cfg) are loaded by clicking on the desired file and the **OK** button.

- One file can be loaded.

- After loading the file, the contents of the file are shown in the **Analog Channels** and **Digital Channels** columns.
  
  The labels and units of the elements originate from the **COMTRADE** configuration and cannot be changed.
FURTHER INFORMATION ON THE EDITING OF *.CFG- AND *.DAT FILES

The information from the *.cfg file allows the evaluation of the *.dat file. It contains the data from various analog and digital series of measurements of currents and voltages. The data is broken down into individual data sets and shown in hex format.

*.cfg files

- The last entry of a file of this data type is a time multiplier. This entry is multiplied by the time stamp of one of each entry from the *.dat file when a disturbance is read in. If there is no time multiplier, a factor with the value of 1 is assumed internally. The *.cfg file is not changed in the process.

- Certain standards apply for the entries of the digital measured values. Example of a standard-compliant entry of a digital measured value: 1,LOPHC,,0. However, if there is no zero at the end of the entry, the COMTRADE-Viewer adds this internally. The *.cfg file is not changed in the process.

*.dat files

- The COMTRADE-Viewer is in a position to read in files of this data type that start with the index 0 or >1. In doing so, a check is constantly carried out to see whether these data sets are numbered continually in discrete steps from 1. If there are data sets that are not correctly numbered, the file cannot be read in.

ANALOG CHANNELS

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Liste der verfügbaren Kanäle]</td>
<td>Selection of the elements to be visualized. Multiple selection by clicking on the desired entry in the list. Selected elements are shown with a colored background. Another mouse click undoes the selection of the entry.</td>
</tr>
</tbody>
</table>

Select All

Selects all elements from the list.

Deselect All

Deactivates the existing selection of elements.

DIGITAL CHANNELS

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Liste der verfügbaren Kanäle]</td>
<td>Selection of the elements to be visualized Multiple selection by clicking on the desired entry in the list. Selected elements are shown with a colored background. Another mouse click undoes</td>
</tr>
</tbody>
</table>
### SHOW SELECTION

To show your selection in the graphic view, click on the **Apply** button.

**Note:** Clicking on the vertically-arranged COMTRADE Viewer Configuration switching only changes the view. An amended selection of the channels is not taken into account in the process.

### 6.5.4.7 Runtime view - visualization of COMTRADE data

The selected channels are visualized in the graph view of the COMTRADE-Viewer WPF element. The coloring can be configured in the zenon Editor.

Files that are compliant with the **IEEE C37.111-2013** (or **IEC 60255-24:2013**) standard can be read in.

X-values are necessary for the display, which represent the time stamps of the respective recorded data points.

The X-values can be saved in the *.dat file directly.

If this is not the case, there is a calculation of the time stamp using the following entries of the *.cfg file:

- Start time of recording the disturbance (date and time of the first data point)
- Number of recorded data points (**Samplerate**)  
- Number of data points for each query (**Rate**)  

### EXPORT OF THE SELECTED DATA

The selected analog and digital channels can be exported to a CSV file with the **CSV-Export** button.

### GRAPH VIEW

The graph view of the COMTRADE-Viewer is divided into three sections:

- Current amperage  
  Upper area  
- Voltage  
  Mid area
AXIS LABELING

- Horizontal axis
  The horizontal axis represents the complete time period as illustrated in the COMTRADE file (*.dat).
  The scaling of this time axis depends on the enlargement level. The higher the enlargement selected, the more detailed the time display.

- Vertical axis
  The vertical axis represents the values.
  - The scaling of the value axis depends on the enlargement level. The greater the enlargement selected, the more detailed the display of values.
  - The labeling of the analog channels is shown vertically next to the values and corresponds to the measuring unit as defined in the COMTRADE file (*.cfg).
  - The digital channels are displayed in the sequence as defined in the COMTRADE file (*.cfg). The Channel identifier of the COMTRADE file serves as an identifier.

KEY

The color key of the graphs is shown at the head of the graph.
- The labeling of the digital channels corresponds to the channel description as defined in the COMTRADE file (*.cfg).
- The colors for each channel are assigned automatically with the configured color palette.
- The time is displayed in a footer under the graph. The start time is displayed as a text.

**NAVIGATION AND ZOOM**

Navigation (scroll and zoom) is always applied to all three areas of the graphic display.

- You can move the display within the horizontal time line with the scroll bar.
- Zoom in and zoom out
  - You can zoom at the current position of the mouse pointer in the graph view or reduce the enlargement.
  - The selected area is displayed by selecting a display area with the mouse button held down.
    **Note:** The display of the values is always amended to the selected area. As a result, this can lead to a flattening of the curve in the enlarged graph view.
- Double clicking on the scroll bar resets the enlargement.

**ANALYSIS**

The precise values at the position of the mouse pointer are visualized with a display in value blocks. A crosshair offers additional visual support with the exact determination of the reading position.
6.5.5 Energy class diagram

The energy class diagram, WPF element is available to partners of COPA-DATA and is available to them via the COPA-DATA Partner Community (https://www.copadata.com/en-us/partner-community/).

A reaction matrix must be used to model an energy class diagram. This reaction matrix must be linked to the variable whose value is envisaged for display and distribution in energy classes. The name of the variable must be transferred to the "zVariableName" property.

**REACTION MATRIX FOR ENERGY CLASS DIAGRAM**

The linked reaction matrix must correspond to the following schematic:

- The first status must be an area, or a "less than" definition.
Then as many different areas as desired can be defined.
The last status must be an area or a "greater than" definition.

The following is applicable for project configuration:

1. If the first status is an area and the value of the variable comes under this area, the first status in the diagram is shown nevertheless. The same is applicable for the last status the other way round.

2. The colors that the WPF diagram uses for the classes are the limit value colors that were defined in the reaction matrix.

3. The letters for the classes are set in alphabetical order starting with "A".

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>zenonFontID</td>
<td>ID for a font from the first font list (font size is not taken into account)</td>
<td>Integer</td>
</tr>
<tr>
<td>zenonNumberOfDecimalPlaces</td>
<td>Number of displayed decimal points</td>
<td>Integer</td>
</tr>
<tr>
<td>zenonVariableName</td>
<td>Name of the variable to be displayed.</td>
<td>String</td>
</tr>
</tbody>
</table>

**Note:** Additional VSTA programming is necessary for the display of the energy class diagram in the zenon web client. You can find details on this in the display of WPF elements in the zenon web client (on page 109).

### 6.5.6 Pareto diagram

The Pareto diagram, WPF element is available to partners of COPA-DATA and is available to them via the COPA-DATA Partner Community (https://www.copadata.com/en-us/partner-community/).

An example of a Pareto diagram in Runtime is shown below:
The following settings can be made in the WPF configuration window under COPADATA-ELEMENT:

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>zenonBarColor1</td>
<td>Color of the first Bar</td>
<td>COLOR (STRING)</td>
</tr>
<tr>
<td>zenonBarColor2</td>
<td>Color of the second Bar</td>
<td>COLOR (STRING)</td>
</tr>
<tr>
<td>zenonBarColor3</td>
<td>Color of the third Bar</td>
<td>COLOR (STRING)</td>
</tr>
<tr>
<td>zenonBarColor4</td>
<td>Color of the fourth Bar</td>
<td>COLOR (STRING)</td>
</tr>
<tr>
<td>zenonBarColor5</td>
<td>Color of element fifth Bar</td>
<td>COLOR (STRING)</td>
</tr>
<tr>
<td>zenonBarColor6</td>
<td>Color of element sixth Bar</td>
<td>COLOR (STRING)</td>
</tr>
<tr>
<td>zenonBarColor7</td>
<td>Color of element seventh Bar</td>
<td>COLOR (STRING)</td>
</tr>
<tr>
<td>zenonBarColor8</td>
<td>Color of element eighth Bar</td>
<td>COLOR (STRING)</td>
</tr>
<tr>
<td>zenonBarColor9</td>
<td>Color of element ninth Bar</td>
<td>COLOR (STRING)</td>
</tr>
<tr>
<td>zenonBarColor10</td>
<td>Color of element tenth Bar</td>
<td>COLOR (STRING)</td>
</tr>
<tr>
<td>zenonColorPercentageLine</td>
<td>Color of the percentage line (relative sum frequency).</td>
<td>COLOR (STRING)</td>
</tr>
</tbody>
</table>
| zenonInitialisationTime | Denotes how long the wait for the initialization of controls is. | INTEGER
|                       | Default: 150 ms                                   |                  |
| zenonLineVisibility   | Visibility of the percentage line (relative sum frequency). | BOOLEAN          |
| zenonVariable1_Label  | Labeling for the 1st Bar                           | STRING           |
| zenonVariable1_Value  | Value of the 1st Bar                               | DOUBLE           |
| zenonVariable2_Label  | Labeling for the 2nd Bar                           | STRING           |
| zenonVariable2_Value  | Value of the 2nd Bar                               | DOUBLE           |
| zenonVariable3_Label  | Labeling for the 3rd Bar                           | STRING           |
| zenonVariable3_Value  | Value of the 3rd Bar                               | DOUBLE           |
| zenonVariable4_Label  | Labeling for the 4th Bar                           | STRING           |
| zenonVariable4_Value  | Value of the 4th Bar                               | DOUBLE           |
| zenonVariable5_Label  | Labeling for the 5th Bar                           | STRING           |
| zenonVariable5_Value  | Value of the 5th Bar                               | DOUBLE           |
The following events can be used and linked to zenon functions:

<table>
<thead>
<tr>
<th>Event</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>zenonBar1Click</td>
<td>Function that is executed when the 1st bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar2Click</td>
<td>Function that is executed when the 2nd bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar3Click</td>
<td>Function that is executed when the 3rd bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar4Click</td>
<td>Function that is executed when the 4th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar5Click</td>
<td>Function that is executed when the 5th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar6Click</td>
<td>Function that is executed when the 6th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar7Click</td>
<td>Function that is executed when the 7th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar8Click</td>
<td>Function that is executed when the 8th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar9Click</td>
<td>Function that is executed when the 9th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>Event</td>
<td>Function</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>zenonBar10Click</td>
<td>Function that is executed when the 10th bar is clicked on.</td>
<td>Function</td>
</tr>
</tbody>
</table>

### 6.5.7 Circular gauge control

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CurrentValue</strong></td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>IsReversed</strong></td>
<td>Scale orientation - clockwise or anti-clockwise.</td>
<td>Boolean</td>
</tr>
<tr>
<td><strong>ElementFontFamily</strong></td>
<td>Element font.</td>
<td>Font</td>
</tr>
<tr>
<td><strong>MinValue</strong></td>
<td>Minimum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>MaxValue</strong></td>
<td>Maximum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleRadius</strong></td>
<td>Radius of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleStartAngle</strong></td>
<td>Angle at which the scale starts.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleLabelRotationMode</strong></td>
<td>Alignment of the scale caption.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Automatic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Surround In</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Surround Out</td>
<td></td>
</tr>
<tr>
<td><strong>ScaleSweepAngle</strong></td>
<td>Angel area which defines the size of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleLabelFontSize</strong></td>
<td>Font size of the scale caption.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleLabelColor</strong></td>
<td>Font color of the scale caption.</td>
<td>Color</td>
</tr>
<tr>
<td><strong>ScaleLabelRadius</strong></td>
<td>Radius on which the scale caption is orientated.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleValuePrecision</strong></td>
<td>Accuracy of the scale caption.</td>
<td>Integer</td>
</tr>
<tr>
<td><strong>PointerStyle</strong></td>
<td>Shape of the pointer displaying the value.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>- Arrow</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Function</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>MajorTickColor</td>
<td>Color of main ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>MinorTickColor</td>
<td>Color of sub ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>MajorTickSize</td>
<td>Size of main ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>MinorTickSize</td>
<td>Size of sub ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>MajorTicksCount</td>
<td>Number of main ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>MajorTicksShape</td>
<td>Shape/type of main ticks on the scale.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ Rectangle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ Trapezoid</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ Triangle</td>
</tr>
<tr>
<td>MinorTicksShape</td>
<td>Shape/type of sub ticks on the scale.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ Rectangle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ Trapezoid</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ Triangle</td>
</tr>
<tr>
<td>MinorTicksCount</td>
<td>Number of sub ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>PointerSize</td>
<td>Size of the pointer.</td>
<td>Size</td>
</tr>
<tr>
<td>PointerCapRadius</td>
<td>Size of the pointer fastening point.</td>
<td>Double</td>
</tr>
<tr>
<td>PointerBorderBrush</td>
<td>Color of pointer border.</td>
<td>Brush</td>
</tr>
<tr>
<td>PointerCapStyle</td>
<td>Shape/type of pointer fastening point.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ BackCap</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ FrontCap</td>
</tr>
<tr>
<td>Property</td>
<td>Function</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>PointerCapBorderBrush</td>
<td>Color of pointer fastening point.</td>
<td>Brush</td>
</tr>
<tr>
<td>PointerBrush</td>
<td>Color of pointer.</td>
<td>Brush</td>
</tr>
<tr>
<td>GaugeBorderBrush</td>
<td>Color of the element border.</td>
<td>Brush</td>
</tr>
<tr>
<td>GaugeBackgroundColorBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
<tr>
<td>PointerCapColorBrush</td>
<td>Color of pointer fastening point.</td>
<td>Brush</td>
</tr>
<tr>
<td>GaugeMiddlePlate</td>
<td>Radius of the element background middle plate.</td>
<td>Double</td>
</tr>
<tr>
<td>PointerOffset</td>
<td>Offset of the pointer (displacement).</td>
<td>Double</td>
</tr>
<tr>
<td>RangeRadius</td>
<td>Radius of the total range display.</td>
<td>Double</td>
</tr>
<tr>
<td>RangeThickness</td>
<td>Thickness of the total range display.</td>
<td>Double</td>
</tr>
<tr>
<td>RangeStartValue</td>
<td>Start value of the total range display.</td>
<td>Double</td>
</tr>
<tr>
<td>RangeEndValue</td>
<td>End value of an area. x stands for the range. The end value is at the same time the start value of the next respective range:</td>
<td>Double</td>
</tr>
<tr>
<td></td>
<td>▶ Range1EndValue: End value of the 1st area and start value of the 2nd range.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Range2EndValue: End value of the 2nd area and start value of the 3rd range.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Range3EndValue: End value of the 3rd area and start value of the 4th range.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Range4EndValue: End value of the 4th area and start value of the 5th range.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Range5EndValue: End value of the 5th area and start value of the 6th range.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Range6EndValue: End value of the 6th range.</td>
<td></td>
</tr>
<tr>
<td>RangeColorBrush</td>
<td>Color of the respective area. x stands for the range. Available are:</td>
<td>Brush</td>
</tr>
<tr>
<td></td>
<td>▶ Range1ColorBrush: Color of the first range.</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Function</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------</td>
<td>-------</td>
</tr>
<tr>
<td>Range2ColorBrush</td>
<td>Color of the second range.</td>
<td></td>
</tr>
<tr>
<td>Range3ColorBrush</td>
<td>Color of the third range.</td>
<td></td>
</tr>
<tr>
<td>Range4ColorBrush</td>
<td>Color of the fourth range.</td>
<td></td>
</tr>
<tr>
<td>Range5ColorBrush</td>
<td>Color of element fifth range.</td>
<td></td>
</tr>
<tr>
<td>Range6ColorBrush</td>
<td>Color of element sixth range.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Cannot be set in zenon. You can find information on the use of CDWPF to change color values in the chapters [Referenced assemblies](#) (on page 8), [CDWPF files](#) (on page 48) and [Configurable control properties - color display](#) (on page 70).

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScaleOuterBorderBrush</td>
<td>Color of the scale border.</td>
<td>Brush</td>
</tr>
<tr>
<td>ScaleBackgroundBrush</td>
<td>Color of scale background.</td>
<td>Brush</td>
</tr>
<tr>
<td>ValueTextFrameStyle</td>
<td>Shape/type of value display.</td>
<td></td>
</tr>
<tr>
<td>ValueTextContent</td>
<td>Content of the value display.</td>
<td></td>
</tr>
<tr>
<td>ValueTextSize</td>
<td>Font size of the value display.</td>
<td>Double</td>
</tr>
<tr>
<td>ValueTextColor</td>
<td>Font size of the value display.</td>
<td>Color</td>
</tr>
<tr>
<td>IsGlasReflection</td>
<td>Activate the glass effect on the element.</td>
<td>Boolean</td>
</tr>
<tr>
<td>GaugeOffsett</td>
<td>Lowering the rotation point of the whole element.</td>
<td>Double</td>
</tr>
</tbody>
</table>
6.5.8 Sankey diagram

The Sankey diagram, WPF element is available to partners of COPA-DATA and is available to them via the COPA-DATA Partner Community (https://www.copadata.com/en-us/partner-community/).

The Sankey wizard must be used to model a Sankey diagram. The wizard creates an XML file that is then evaluated by the WPF element. To do this, the \texttt{zSankeyName} property must be given the name of the XML file. The XML file must be in the \textit{Other} folder of a project. This is saved there by the wizard.

An example of a Sankey diagram in Runtime is shown below:

The following settings can be made in the WPF configuration window under \texttt{COPADATA-ELEMENT}:

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>FontSize</td>
<td>Font size of the texts.</td>
<td>Integer</td>
</tr>
<tr>
<td>\texttt{zBackgroundColor}</td>
<td>Background color of the diagram.</td>
<td>Color(String)</td>
</tr>
<tr>
<td>\texttt{zFontColor}</td>
<td>Color of the texts.</td>
<td>Color(String)</td>
</tr>
<tr>
<td>\texttt{zFontFamily}</td>
<td>Font of all texts.</td>
<td>Font(String)</td>
</tr>
<tr>
<td>\texttt{zLossDetectionActive}</td>
<td>Automatic loss detection activated/deactivated. If \texttt{true}, then losses are automatically shown at a node points as flows.</td>
<td>Bool</td>
</tr>
<tr>
<td>\texttt{zNoDataText}</td>
<td>Text that is displayed if there are no values to display and \texttt{zPreviewActive} is \texttt{false}.</td>
<td>String</td>
</tr>
<tr>
<td>\texttt{zNoValidXMLText}</td>
<td>Text that is displayed if no valid XML file with entered name has been found and \texttt{zPreviewActive} is \texttt{false}.</td>
<td>String</td>
</tr>
<tr>
<td>\texttt{zNumberOfDecimalPlaces}</td>
<td>Denotes how many decimal places are to be displayed.</td>
<td>Integer</td>
</tr>
<tr>
<td>\texttt{zPreviewActive}</td>
<td>Display of a preview activated/deactivated. The preview can be displayed if there is no data present (the modeled mode)</td>
<td>Bool</td>
</tr>
</tbody>
</table>
### Property | Function | Value
--- | --- | ---
| | diagram is filled with default values) or the XML file was not found or this does not contain a valid definition (an example Sankey diagram is displayed). | |
| `zRefreshRate` | Rate at which the diagram is refreshed in ms. | `Integer`
| `zSankeyName` | Name of the XML file with the modeling of the diagram. | `String`
| `zShowRelativeValues` | Display of the values in absolute false or relative values true. | `Bool`

**Note:** Additional VSTA programming is necessary for the display of the Sankey diagrams in the zenon Web Client. You can find details on this in the display of WPF elements in the zenon Web Client (on page 109).

### 6.5.9 Temperature indicator - TemperatureIndicatorControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
</table>
| `CurrentValue` | Current value which should be displayed. | `Double`
| `MinValue` | Minimum value of the scale. | `Double`
| `MaxValue` | Maximum value of the scale. | `Double`
| `MajorTicksCount` | Number of main ticks on the scale. | `Integer`
| `MinorTicksCount` | Number of sub ticks on the scale. | `Integer`
| `TickNegativColor` | Color of the negative main tick (gradient to `TickPositivColor`). | `Color`
| `TickPositivColor` | Color of the positive main tick (gradient to `TickNegativColor`). | `Color`
| `MinorTickColor` | Color of the sub ticks. | `Color`
| `ElementBorderBrush` | Color of the element border. | `Brush`
| `ElementBackgroundBrush` | Color of element background. | `Brush`
| `ElementGlasReflection` | Activate the glass effect on the element. | `Visibility`
<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ElementFontFamily</td>
<td>Element font.</td>
<td>Font</td>
</tr>
<tr>
<td>IndicatorColor</td>
<td>Color of the indicator fill color.</td>
<td>Color</td>
</tr>
<tr>
<td>IndicatorBorderColor</td>
<td>Color of the indicator border.</td>
<td>Color</td>
</tr>
<tr>
<td>MajorTickSize</td>
<td>Size of main ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>MinorTickSize</td>
<td>Size of sub ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>ScaleLetteringDistance</td>
<td>Distance of the scale caption (vertical), each x. main tick should be captioned.</td>
<td>Integer</td>
</tr>
<tr>
<td>IndicatorScaleDistance</td>
<td>Distance between indicator and scale (horizontal).</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleFontSize</td>
<td>Font size of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleFontColor</td>
<td>Font color of the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>Unit</td>
<td>Unit.</td>
<td>String</td>
</tr>
<tr>
<td>ElementStyle</td>
<td>Shape/type of element.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SmallFrame</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>

### 6.5.10 Universal slider - UniversalReglerControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentValue</td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td>ElementFontFamily</td>
<td>Element font.</td>
<td>Font</td>
</tr>
<tr>
<td>MinValue</td>
<td>Minimum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>MaxValue</td>
<td>Maximum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>Radius</td>
<td></td>
<td>Double</td>
</tr>
<tr>
<td>ScaleRadius</td>
<td>Radius of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleStartAngle</td>
<td>Angle at which the scale starts.</td>
<td>Double</td>
</tr>
<tr>
<td>Property</td>
<td>Function</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>ScaleLabelRotationMode</td>
<td>Alignment of the scale caption.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Automatic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- SurroundIn</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- SurroundOut</td>
</tr>
<tr>
<td>ScaleSweepAngle</td>
<td>Angel area which defines the size of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleLabelFontSize</td>
<td>Font size of the scale caption.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleLabelColor</td>
<td>Font color of the scale caption.</td>
<td>Color</td>
</tr>
<tr>
<td>ScaleLabelRadius</td>
<td>Radius on which the scale caption is orientated.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleValuePrecision</td>
<td>Accuracy of the scale caption.</td>
<td>Integer</td>
</tr>
<tr>
<td>ElementStyle</td>
<td>Display type of the element</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Knob</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Plate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- None</td>
</tr>
<tr>
<td>MajorTickColor</td>
<td>Color of main ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>MinorTickColor</td>
<td>Color of sub ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>MajorTickSize</td>
<td>Size of main ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>MinorTickSize</td>
<td>Size of sub ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>MajorTicksCount</td>
<td>Number of main ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>MajorTicksShape</td>
<td>Shape/type of main ticks on the scale.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Rectangle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Trapezoid</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Triangle</td>
</tr>
<tr>
<td>MinorTicksShape</td>
<td>Shape/type of sub ticks on the scale.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Rectangle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Trapezoid</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Triangle</td>
</tr>
<tr>
<td>Property</td>
<td>Function</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>MinorTicksCount</td>
<td>Number of sub ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>BackgroundBorderBrush</td>
<td>Color of the element border.</td>
<td>Brush</td>
</tr>
<tr>
<td>BackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
<tr>
<td>PointerCapColorBrush</td>
<td>Color of pointer fastening point.</td>
<td>Brush</td>
</tr>
<tr>
<td>GaugeMiddlePlate</td>
<td>Radius of the element background middle plate.</td>
<td>Double</td>
</tr>
<tr>
<td>ValueFontSize</td>
<td>Font size of the value display.</td>
<td>Double</td>
</tr>
<tr>
<td>ValueFontColor</td>
<td>Font size of the value display.</td>
<td>Color</td>
</tr>
<tr>
<td>IsGlasReflection</td>
<td>Activate the glass effect on the element.</td>
<td>Boolean</td>
</tr>
<tr>
<td>KnobBrush</td>
<td>Color of the knob.</td>
<td>Brush</td>
</tr>
<tr>
<td>IndicatorBrush</td>
<td>Color of the indicator.</td>
<td>Brush</td>
</tr>
<tr>
<td>IndicatorBackgroundBrush</td>
<td>Background color of the inactive indicator.</td>
<td>Brush</td>
</tr>
<tr>
<td>KnobSize</td>
<td>Diameter of the knob.</td>
<td>Double</td>
</tr>
<tr>
<td>KnobIndicatorSize</td>
<td>Indicator size of the knob.</td>
<td>Size</td>
</tr>
<tr>
<td>ElementSize</td>
<td>Size of the element.</td>
<td>Size</td>
</tr>
<tr>
<td>VisibilityKnob</td>
<td>Activating of the knob.</td>
<td>Boolean</td>
</tr>
<tr>
<td>ValuePosition</td>
<td>Position of the value display.</td>
<td>Double</td>
</tr>
<tr>
<td>ValueVisibility</td>
<td>Activating the value display.</td>
<td>Boolean</td>
</tr>
</tbody>
</table>

### 6.5.11 Waterfall chart

The **waterfall diagram** WPF element is available to partners of COPA-DATA and is available to them via the COPA-DATA Partner Community (https://www.copadata.com/en-us/partner-community/).

The Meaning and waterfall chart Wizard must be used to model a waterfall diagram. A waterfall can be modeled with this wizard. The information is saved directly to the variables in the **Parameters for waterfall diagram** property (Analyzer variable properties group).
An example of a waterfall diagram in Runtime is shown below:

Note: This screenshot is only available in English.

The following settings can be made in the WPF configuration window under COPADATA-ELEMENT:

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>zenonRefreshRate</td>
<td>Time between the refreshes of the diagram in milliseconds.</td>
<td>Integer</td>
</tr>
<tr>
<td>zenonWaterfallIdentifier</td>
<td>Name of the waterfall diagram.</td>
<td>String</td>
</tr>
<tr>
<td>zenonZSystemModel</td>
<td>Equipment group of the variables used.</td>
<td>String</td>
</tr>
</tbody>
</table>

Note: Additional VSTA programming is necessary for the display of the waterfall diagram in the zenon Web Client. You can find details on this in the display of WPF elements in the zenon Web Client (on page 109).

**LINK BARS TO ZENON FUNCTION**

The bars of a waterfall diagram can be linked to a function in the Runtime. For display in the Runtime, the bars, labeling and display of the values for execution with the click of a mouse can be configured for the waterfall diagram.

Carry out the following configuration to link the columns of your waterfall diagram to a function:

1. Configure the WPF element for the waterfall diagram.
   
   Note: To do this, use the Meaning and Waterfall Chart wizard if possible.
2. Engineer a zenon function.
   a) Create a new function:
      In the toolbar or in the context menu of the Functions node, select **New function**.
      The dialog to select a function is opened.
   b) Select the desired function.
   c) Set the parameters for function.

3. Name the function in the **Name** property.
   **Note:** The function name must contain the variables for the waterfall diagram without color code!
   You can also find these parameters in the **Parameters for waterfall diagram** variable property in the **Analyzer** properties group.

4. Link the function to the exact same equipment group as the variables.
   **Note:** You can find this linking in the **Equipment Groups** property of the function.

The following is applicable for this project configuration:

- The function and the linked variables must be present in the same zenon project.
- The variables must be linked to an equipment group.
- The function must be linked to the same equipment group as the variables.

**Example**

For a bar with the waterfall definition \( WF = WF1,02,05,#E9ED92; \) The function name, for example **Function_WF1,02,05**, is to be used.

### 6.5.12 BACnet WPF Control

The **BACnet Schedule Control** WPF element is available to partners of COPA-DATA and is available to them via the COPA-DATA Partner Community (https://www.copadata.com/en-us/partner-community/).

The control offers the possibility to configure BACnet schedule objects in a graphical user interface and to display these objects.

#### 6.5.12.1 Installation

Requirements:

- You must be a registered COPA-DATA Partner.
You need to have access to the COPA-DATA Partner Community already.

DOWNLOAD WPF ELEMENT FROM THE COPA-DATA PARTNER PORTAL

Carry out the following steps to download the WPF element:

2. Log in in the area called MY AREA.
3. Enter "Partner" as a search term by the microscope.
   COPA-DATA Partner Community appears with a link in the results.
4. Click on the link.
5. In the Partner Login Area, click on MORE.
   The Overview tab is opened.
6. Switch to the Documents & Downloads tab.
7. Under SELECT CATEGORY, activate the WPF element checkbox.
8. Click Search.
   The labeling is hidden.
   An orange frame surrounds the search field.
9. Click in the frame and enter Bacnet.
10. The BACNetWPFScheduler is shown.
11. Under Actions, click on the orange symbol to download the BACnet Schedule Control.
12. Save the folder locally.
13. Unzip the file.
14. Open the folder that contains the files BacnetSchedulerControl.xaml and BacnetSchedulerWPF.dll.

IMPORT BACNET SCHEDULE CONTROL IN ZENON EDITOR

To create a WPF element

1. Open the zenon Editor
2. Go to the Files node in the project manager.
3. Expand the view of this node by clicking on the [+] button.
   The tree view is unfolded and the subnodes are displayed.
4. Go to the Graphics subnode.
a) Select the Import file entry in the tool bar of the detail view. The file selection dialog is opened.

b) Select the file called BacnetSchedulerControl.xaml.

c) Confirm the selection by clicking on the Open button

5. Go to the Miscellaneous subnode.

   a) Select the Import file entry in the tool bar of the detail view. The file selection dialog is opened.

   b) Select the file called BacnetSchedulerWPF.dll.

   c) Confirm the selection by clicking on the Open button

6.5.12.2 Engineering in the zenon Editor

Carry out the following steps to use the BacnetScheduler in zenon:

1. Create a new screen.
   To do this, select the New screen command in the tool bar or in the context menu of the Screens node.

2. Change the properties of the screen:
   a) Name the screen in the Name property.

   b) Select a desired screen type in the Screen type property (recommended screen type: Standard).

   c) Select the desired frame in the Frame property.

3. Configure the content of the screen:
   a) Open the screen in which the WPF element is to be inserted.

   b) In the Elements tool bar, select WPF element (WPF).

   c) Drag the WPF element in the screen with the left mouse button.

   d) The File selection window is opened.

   e) Select the file BacnetSchedulercontrol.xaml and confirm the input by clicking on OK.

   f) The WPF element is added.

4. Amend the size of the WPF element to your zenon screen.
   a) Highlight the desired WPF element.

   b) Switch to the Position property group.
c) Set the parameters for the element width using the **Width [pixels]** property and the height with the **Height [pixels]** property. Recommended minimum size: 920 x 920 pixels

### 6.5.12.3 Configurable control properties

Carry out the following steps to set the parameters for your BACnet WPF control:

1. Highlight the desired WPF element.
2. Switch to the **WPF links** property group.
3. Click the ... button in the **Configuration** property
4. The dialog to enter elements is opened.
5. Expand the **BacnetControlGrid** node in the **Existing Elements** area. The **BacnetSchedulerControl** is visible in the node.
6. Click on the **BacnetSchedulerControl** entry. The view in the **Action Linkings** area is updated.
7. Set the parameters for the WPF content:
   a) Click once on the respective line in the **Linking Type** column. A drop-down list is opened.
   b) Select the corresponding linking type in the drop-down list.
   c) Click in the **Linking** column to open the **element input** dialog. It is amended to the configured linking type (such as selection of a variable, entry of a value ...)

8. Confirm your parameter settings by clicking on **OK**.

**POSSIBLE TYPES OF LINKING**

One or more parameters can be linked for this WPF:

- **StartDate**
- **EndDate**
- **ZenonEffectivePeriod**
- **ZenonWeeklySchedule**
- **ZenonExceptionSchedule**

**Information**

The setting of the parameters of the WPF element are visualized in Zenon in the **WPF links** properties group of the WPF element. In doing so, each WPF linking is displayed with a separate subnode or overview of properties.
6.5.12.4 Runtime view

In zenon Runtime, existing BACnet schedule objects can be read by the PLC, modified in the Runtime and saved back to the PLC.

The user interface in Runtime is divided into three areas:

- **Effective Period**
- **Weekly Schedule**
- **Exception Schedule**
Note: The graphical user interface is only available in English.

6.5.12.4.1 Runtime view

In this area, the value of the variable that has been linked in configuration of the control (on page 96) in the Editor for the ZenonEffectivePeriod option is displayed.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Timespan</td>
<td>The parameters for the Effective Period are set in Runtime. Input is in the input fields From and To.</td>
</tr>
<tr>
<td></td>
<td>- Inactive: The Effective Period is not used.</td>
</tr>
<tr>
<td></td>
<td>- Active: The Effective Period is entered in Runtime.</td>
</tr>
<tr>
<td></td>
<td>Default: inactive</td>
</tr>
<tr>
<td>From</td>
<td>Start of the Effective Period. Entry of the date. Manual entry or selection from a calendar. The calendar is displayed by clicking on the calendar symbol as a drop-down dialog.</td>
</tr>
<tr>
<td></td>
<td>Default: 1.1.2018</td>
</tr>
<tr>
<td></td>
<td>Note: Only active if the Use Timespan option is active.</td>
</tr>
<tr>
<td>To</td>
<td>End of the Effective Period. Entry of the date. Manual entry or selection from a calendar. The calendar is displayed by clicking on the calendar symbol as a drop-down dialog.</td>
</tr>
<tr>
<td></td>
<td>Default: 31.12.2018</td>
</tr>
<tr>
<td></td>
<td>Note: Only active if the Use Timespan option is active.</td>
</tr>
<tr>
<td>Save</td>
<td>Writes the current configuration for the Effective Period to the PLC.</td>
</tr>
</tbody>
</table>
6.5.12.4.2 Runtime view

**Weekly Schedule**

<table>
<thead>
<tr>
<th>Day</th>
<th>Time</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In this area, the value of the variable that has been linked in configuration of the control (on page 96) in the Editor for the **ZenonWeeklySchedule** option is displayed.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| [List of the content of the loaded Weekly Schedules] | The schedule is displayed in the **Weekly Schedule** list as a list entry. The parameters are set for the respective list entry:
  - **Day**
    Selection of the day from a drop-down list.
  - **Time**
    Entry of the time
    Input format: *hh:mm:ss:ms*
  - **Value**
    Value of the respective schedule. The value represents that of the data type:
    - [0] = NULL
    - [1] = BOOLEAN
    - [2] = Unsigned
    - [3] = REAL
    - [5] = Double
    - [6] = OctetString
    - [7] = CharacterString |
Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[8] = BitString</td>
<td></td>
</tr>
<tr>
<td>[9] = Enumerated</td>
<td></td>
</tr>
<tr>
<td>[10] = Date</td>
<td></td>
</tr>
<tr>
<td>[12] = BACnetObjectIdentifier</td>
<td></td>
</tr>
</tbody>
</table>

Default: [0]

Note: The data type is required in the Values parameter when configuring. The data type is given as a number according to the top list. Note that this must be given in square brackets []. Example: [1] for BOOLEAN.

In addition to the data type, the corresponding value of the data type can also be configured. This value is entered after the data type.

Examples:

[1] TRUE
For Boolean with value TRUE

[10] 2/3/2021
For data type date with value February 3, 2021

Date entry in BACnet standard format.

Load

Reads the current configuration for the Weekly Schedule from the PLC.

The loaded Weekly Schedule is displayed in the Weekly Schedule list.

Note: With a Load, all unsaved configurations are replaced with values from the PLC in Runtime without a request for confirmation.

New

Creates a new Weekly Schedule.

Delete

Deletes the selected entry from the Weekly Schedule list. The entry is deleted immediately without a request for confirmation.

Multiple selection is possible, but is ignored when clicking on Delete.

Save

Writes the current configuration for the Weekly Schedules to the PLC.
6.5.12.4.3 Runtime view

In this area, the value of the variable that has been linked in configuration of the control (on page 96) in the Editor for the ZenonExceptionSchedule option is displayed.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Exception Schedule</td>
<td>Type of schedule for exceptions (Exception Schedule). Selection from options box:</td>
</tr>
<tr>
<td></td>
<td>Selection from options box:</td>
</tr>
<tr>
<td></td>
<td>• <em>DateRange</em>:* The Exception Schedule is defined with a time period. *</td>
</tr>
<tr>
<td></td>
<td>The time period is configured with the options <em>From, Day, To</em> and <em>Day</em>.</td>
</tr>
<tr>
<td></td>
<td>• <em>SingleDate</em>:* The Exception Schedule is defined with a precise day. *</td>
</tr>
<tr>
<td></td>
<td>The day is configured with the options <em>Single</em> and <em>Day</em>.</td>
</tr>
<tr>
<td></td>
<td>• <em>WeekNDay</em>:* The Exception Schedule is defined with</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Parameters | Description
--- | ---
several days. These days are configured in the drop-down lists for **WeekNDay**.  

- **CalendarRef**  
The Exception Schedule is defined with a reference to an existing BACNet calendar object.

| From (for Eventtype DateRange) | Start of the Eventtype **Exception Schedule**. Entry of the date. Entry by means of manual entry or selection from a calendar. The calendar is shown by clicking on the calendar symbol as a drop-down dialog. Default: **empty (Select a date)**  
**Note:** Only active if the options **DateRange** or **SingleDate** are active.

| Single (for Eventtype SingleDate) | Weekday of the start of the Eventtype **Exception Schedule**. If a date is configured in the **From** option, the corresponding weekday is automatically set for the option. Selection of the weekday from a drop-down list:
  
- **Mon** Monday
- **Tue** Tuesday
- **Wed** Wednesday
- **Thu** Thursday
- **Fri** Friday
- **Sat** Saturday
- **Sun** Sunday |
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
|            | Default: *empty*  
|            | **Note:** Only active if the options *DateRange* or *SingleDate* are active. |
| **To**     | End of the Eventtype *Exception Schedule*. Entry of the date.  
|            | Manual entry or selection from a calendar. The calendar is displayed by clicking on the calendar symbol as a drop-down dialog.  
|            | Default: *empty* (*Select a date*)  
|            | **Note:** Only active if the *DataRange* option is active. |
| **Day**    | Weekday of the end of the Eventtype *Exception Schedule*.  
| (in **To** line) | If a date is configured in the **To** option, the corresponding weekday is automatically set for the option.  
|            | Selection of the weekday from a drop-down list:  
|            |   - *Mon*  
|            |     Monday  
|            |   - *Tue*  
|            |     Tuesday  
|            |   - *Wed*  
|            |     Wednesday  
|            |   - *Thu*  
|            |     Thursday  
|            |   - *Fri*  
|            |     Friday  
|            |   - *Sat*  
|            |     Saturday  
|            |   - *Sun*  
|            |     Sunday  
<p>|            | <strong>Note:</strong> Only active if the <em>DataRange</em> option is active. |</p>
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>Priority for the Eventtype in accordance with BACnet standard. Selection from drop-down list: Values 1 - 16</td>
</tr>
<tr>
<td>WeekNDay</td>
<td>Selection of the date for the Eventtype Exception Schedule from drop-down lists.</td>
</tr>
<tr>
<td></td>
<td>▶ Drop-down list 1: Selection of the month</td>
</tr>
<tr>
<td></td>
<td>Note: The <em>any month of year</em> entry corresponds to each month.</td>
</tr>
<tr>
<td></td>
<td>▶ Drop-down list 2: Selection of the day in accordance with prescribed criteria.</td>
</tr>
<tr>
<td></td>
<td>▶ Drop-down list 3: Selection of the weekday</td>
</tr>
<tr>
<td></td>
<td>Note: The <em>any day of week</em> entry corresponds to each weekday of a week.</td>
</tr>
<tr>
<td></td>
<td>Note: Only active if the WeekNDay option is active.</td>
</tr>
<tr>
<td>CalenderRef</td>
<td>Reference to an existing BACnet CalendarObject object.</td>
</tr>
<tr>
<td></td>
<td>Entry of the numerical <em>Object Instance</em> of the BACnet object. This is always a seven-digit bit number in accordance with the BACnet standard.</td>
</tr>
<tr>
<td></td>
<td>Valid input range (in accordance with BACnet standard): 0 - 4194302</td>
</tr>
<tr>
<td></td>
<td>Note: To achieve this, the <em>Object Instance</em> number entered in the control must be filled with a 0 in front.</td>
</tr>
<tr>
<td></td>
<td>Example: CalendarObject <em>Instance Nummer</em> = 1</td>
</tr>
<tr>
<td></td>
<td>Input in control = 0000001</td>
</tr>
<tr>
<td></td>
<td>[List of the content of the loaded Exception Schedules]</td>
</tr>
<tr>
<td></td>
<td>▶ The schedule is displayed in the Exception Schedule list as a list entry. The parameters are set with the listed options:</td>
</tr>
</tbody>
</table>
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- <em>Event Type</em>: Corresponds to the selection of the event types from the option box.</td>
</tr>
<tr>
<td></td>
<td>- <em>Period</em>: Display of the date. The display can vary depending on the selected event type: [Date] - [Date]</td>
</tr>
<tr>
<td></td>
<td>- <em>Priority</em>: Configured priority</td>
</tr>
</tbody>
</table>

### Load

Reads the current configuration for the Exception Schedules on the PLC.

The loaded Exception Schedule is shown in the list.

**Note:** With a Load, all unsaved configurations are replaced with values from the PLC in Runtime without a request for confirmation.

### New

Applies the configuration from the Exception Schedule area and creates a new entry in the list.

### Delete

Deletes the selected entry from the Exception Schedule list. The entry is deleted immediately without a request for confirmation.

Multiple selection is possible, but is ignored when clicking on Delete.

### Save

Writes the current configuration for the Exception Schedules to the PLC.

---

### TIME VALUES

Time values for a configured Exception Schedule Event.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[List of the configured Time values for the selected Exception Schedule Event]</td>
<td>- <em>Time</em>: Entry of the time Input format: <em>hh:mm:ss:ms</em></td>
</tr>
<tr>
<td></td>
<td>- <em>Value</em>: Value of the respective schedule. The value represents that of the data type:</td>
</tr>
<tr>
<td>Parameters</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>[0] = NULL</td>
<td></td>
</tr>
<tr>
<td>[1] = BOOLEAN</td>
<td></td>
</tr>
<tr>
<td>[2] = Unsigned</td>
<td></td>
</tr>
<tr>
<td>[3] = REAL</td>
<td></td>
</tr>
<tr>
<td>[5] = Double</td>
<td></td>
</tr>
<tr>
<td>[6] = OctetString</td>
<td></td>
</tr>
<tr>
<td>[7] = CharacterString</td>
<td></td>
</tr>
<tr>
<td>[8] = BitString</td>
<td></td>
</tr>
<tr>
<td>[9] = Enumerated</td>
<td></td>
</tr>
<tr>
<td>[10] = Date</td>
<td></td>
</tr>
<tr>
<td>[12] = BACnetObjectIdentifier</td>
<td></td>
</tr>
</tbody>
</table>

Default: [0]

**Note:** Mandatory in the Values parameter when configuring the data type. The data type is given as a number according to the top list. Note that this must be given in square brackets [].

Example: [1] for BOOLEAN.

In addition to the data type, the corresponding value of the data type can also be configured. This value is entered after the data type.

Examples:

[1] TRUE
For Boolean with value TRUE

[10] 2/3/2021
For data type date with value February 3, 2021

Date entry in BACnet standard format.

**New**

Creates a new Time value entry for the selected Exception Schedule Event.

**Delete**

Deletes the selected Time value entry. The entry is deleted immediately without a request for confirmation.

Multiple selection is possible, but is ignored when clicking on Delete.
6.5.12.5 Operation in zenon Runtime

Possibilities of the **BACnet Schedule Control** in zenon Runtime:

- Time period for validity of the schedule (**Effective Period**)
  - Configurable period of validity in days
  - Reading of the existing **Effective Period** from the PLC.
  - Saving of the modified **Effective Period** on the PLC.

- Configuration of weekly schedules:
  - Reading existing **Weekly Schedules** from the PLC.
  - Configuration of new entries for the **Weekly Schedule**
  - Deletion of existing entries
  - Saving of the modified **Weekly Schedules** to the PLC
  - Configuration possibility per entry:
    - day (**Day of the Week**)
    - time per day (local and UTC, depending on the PLC)
    - data type and value

- Configuration of exceptions (**Exception Schedule**)
  - Reading of existing exception schedule from the PLC.
  - Configuration of new entries for the Exception Schedule.
  - Deletion of existing entries.
  - Saving of the modified **Exception Schedule** to the PLC.
  - Configuration possibility per entry:
    - Event Type (**DateRange, SingleDate, WeekNDay, CalendarRef**)
    - Period
    - Priority
    - Time
    - data type and value
6.6 Display of WPF elements in the zenon web client

In order to also be able to also use the pre-made WPF elements "energy class diagram", "Sankey diagram" and "waterfall chart" for the display in a zenon web client, amendments are necessary in the project:

- Engineering in the zenon Editor (on page 109)
- Adapt VSTA code (on page 109)

6.6.1 Engineering in the zenon Editor

Carry out the following project configuration steps in the zenon Editor, in order to also be able to display certain WPF elements in the zenon web client:

PLACE WPF IN THE ZENON SCREEN:

- Place the WPF element in a zenon screen.
- Give it a unique name in the Element ID property. You can find this property in the General properties group.
  
  **Note:** A warning dialog appears if the name for an element has already been issued in another screen.
- Use the element name issued here in the VSTA code.

6.6.2 VSTA code (complex)

In order to add the programmer code for the display of WPF elements in the zenon web client, carry out the following steps:

1. In the zenon Editor, switch to the programmer interfaces node.
2. Select the VSTA node and select the Open VSTA Editor with project add-in... with a right mouse click
3. The dialog to create a VSTA project is opened.
4. Select the C# entry in the Create new VSTA project dialog.
5. Create (copy) the code below.
6. Enter the name of the WPF element in the code.

**Note:** When opening the VSTA editor, note whether the content of the following code is already present in the project configuration. For the display of the WPF element in the web client, compare
the existing code and undertake the necessary additions. Please note the comments in relation to this in the sample code.

VSTA CODE

//As member:
zenOn.IDynPictures zScreens = null;

string[] WPFElements = {"WPF_Control", "WPFWebclient_1", "WPFWebclient_2"}; //Names of the WPF screen elements that appear in the zenon project and that need access to the API (as many/few as you want)

//Add the following three lines of code in the project archive function:
void ThisProject_Active()
{
    zScreens = this.DynPictures();
zScreens.Open += new zenOn.DDynPicturesEvents_OpenEventHandler(zScreens_Open);
zScreens.Close += new zenOn.DDynPicturesEvents_CloseEventHandler(zScreens_Close);
}

//Add the following two lines of code in the project inactive function:
void ThisProject_Inactive()
{
    zScreens.Open -= new zenOn.DDynPicturesEvents_OpenEventHandler(zScreens_Open);
zScreens.Close -= new zenOn.DDynPicturesEvents_CloseEventHandler(zScreens_Close);

    //Final release and garbage collection of any API-Objects.
    FreeObjects();
}

//Add two new event handlers:
void zScreens_Open(zenOn.IDynPicture obDynPicture)
{
    foreach (string element in WPFElements)
    {
        if (obDynPicture.Elements().Item(element) != null)
        {
            obDynPicture.Elements().Item(element).set_WPFProperty("ELEMENT", "zenonVariableLink", this.Variables().Item(0));
        }
    }
}

void zScreens_Close(zenOn.IDynPicture obDynPicture)


```csharp
foreach (string element in WPFEElements)
{
    if (obDynPicture.Elements().Item(element) != null)
    {
        zenOn.IElement zWPFElement = obDynPicture.Elements().Item(element);
        zWPFElement.set_WPFProperty("ELEMENT", "zenonTrigger", true);
        zWPFElement = null;
    }
}

6.6.3 VSTA code (simplified)

If only one WPF element is used in a zenon screen, the following more streamlined code can be used as an alternative. To do this, the names of the WPF element, and the screen in which the element is used, must be entered. This code is then recommended if, for each project, only one of the pre-made WPF elements is used.

VSTA CODE

zenOn.IDynPicture zScreen = zero;
string wpfElement = "WPF_Control"; //Name of the WPF element in the screen
string wpfPicture = "@Details_Overview_Ohnline"; //Name of the zenon screen

//Add to the project active function:
void ThisProject_Active()
{
    zScreen = this.DynPictures().Item(wpfPicture);
    zScreen.Open += new zenOn.OpenEventHandler(zScreen_Open);
    zScreen.Close += new zenOn.CloseEventHandler(zScreen_Close);
}

//Add to the project inactive function:
void ThisProject_Inactive()
{
    zScreen.Open -= new zenOn.OpenEventHandler(zScreen_Open);
    zScreen.Close -= new zenOn.CloseEventHandler(zScreen_Close);
}
void zScreen_Open()
{
if (zScreen.Elements().Item(wpfElement) != null)
{
zScreen.Elements().Item(wpfElement).set_WPFProperty("ELEMENT", "zenonVariableLink", this.Variables().Item(0));
}
}

void zScreen_Close()
{
if (zScreen.Elements().Item(wpfElement) != null)
{
zenOn.IElement zWPFElement = zScreen.Elements().Item(wpfElement);
zWPFElement.set_WPFProperty("ELEMENT", "zenonTrigger", true);
zWPFElement = null;
}
}

### 6.7 Examples: Integration of WPF in zenon

You can see how XAML files are created and integrated as WPF elements in zenon from the following examples:

- Integrate button as WPF XAML in zenon (on page 117)
- Integrate bar graph as WPF XAML in zenon (on page 112)
- Integrate DataGrid Control in zenon (on page 123)

#### 6.7.1 Integrate bar graph as WPF XAML in zenon

Example structure:

- Creating a bar graph (on page 16) in Adobe Illustrator and converting it to WPF
Integrate into zenon
Linking with variables
Adapting the bar graph WPF element

CREATE BAR GRAPH

The first step is to generate a bar graph as described in the Workflow with Adobe Illustrator (on page 16) chapter. To be able to use the XAML file in zenon, insert this in the project tree in the Files/graphics folder.

INTEGRATE BAR GRAPH

Note: A zenon project with the following content is used for the following description:
- An empty screen as a start screen
- Four variables from the internal driver for
  - Scale 0
  - Scale central
  - Scale high
  - Current value
- A variable from the mathematics driver for displaying the current value (255)

To integrate the bar graph:
1. open the empty screen
2. place a WPF element (on page 49) in the screen
3. select XAML file in the properties window
4. Select the desired XAML file (for example bar_graph_vertical.xaml) and close the dialog
ADJUST BAR GRAPH

Before configuration, the scale of the XAML file is adapted if necessary:

To do this:

- Create a new mathematics variable that calculates the new value in relation to the scaling, for example:
  - Variable: 0-1000
  - Mathematic variable (value created in xaml file)*Variable/1000
The XAML file is then configured.

**CONFIGURE BAR GRAPH**

1. Click on the WPF element and select the **Configuration** property.
2. The configuration dialog shows a preview of the selected XAML file.
3. Select the minimum value, the average value and the maximum value and link each of these to the corresponding variable in the **Content** property.

4. Select the **Slider** and link the **Value** property to the mathematics variables (in our example: calculation).
5. Check the project planning in Runtime:

6.7.2 Integrate button as WPF XAML in zenon

Example structure:
- Creating a button (on page 12) in Microsoft Expression Blend
- Integrate into zenon
- Link to a variable and a function
- Adjust the button to the size of the element
- Create button

As a first step, create a button as described in the Create button as XAML file with Microsoft Expression Blend (on page 12) chapter. To be able to use the XAML file in zenon, insert this in the project tree in the Files/Graphics folder.

INTEGRATE BUTTON

Note: A zenon project with the following content is used for the following description:
- An empty screen as a start screen
- An internal variable int of type Int
A function `Function_0` of type `Write/modify set value` with:
- `Direct to hardware` option activated
- The target values should be configured with the value 45.

To integrate the button:
1. open the empty screen
2. place a WPF element (on page 49) in the screen
3. select XAML file in the properties window
4. select the XAML file (e.g. `MyButton.xaml`) and close the dialog
5. select the `Configuration` property

**CONFIGURE THE BUTTON**

The configuration dialog shows a preview of the selected XAML file. All elements named in the XAML file are listed in the tree:

1. select the WPF button, which is in `LayoutRoot -> MyViewBox -> MyButton`
2. Look in the `Properties` `Entry `Content` tab; this contains the button's text
3. Click the `Link type` column
4. Select `Variable` from the drop down list
5. Click in the Link column
6. the variable selection dialog is opened
7. select the int variable to link this variable with the Content property

EVENTS
To also assign events:
1. select the tab Events

2. look for the ‘Click’ entry, this event is triggered by the WPF element, as soon as the button is clicked
3. Click in the Link type column
4. Select Function from the drop down list
5. Click in the Link column
6. the function selection dialog is opened
7. select Function_0
8. Confirm the changes with OK
9. Insert a numerical value element into the screen
10. Link this numerical value element to the int variables too.
11. Compile the Runtime files and start Runtime.
The **WPF element** is displayed in Runtime, the button text is 0. As soon as you click on the button, the **click** event is triggered and the **set value** function is carried out. The value 45 is sent directly to the hardware and both **numerical value** and **button** display the value 45.

![WPF Element Display](image)

Define a set value of 30 via the **numerical value element**; this value is then also assumed by the **WPF element**.

**OPERATING AUTHORIZATION**

Similar to a **numerical value**, a **WPF element** can be locked according to authorizations (lock symbol) or switched to be operable. Set the user authorization level to **7** for the **WPF element** and create a user called **Test** with **authorization level 1**. In addition, set up the functions **Login with dialog** and **Logout**. You link these two functions with 2 new text buttons on the screen.

In the **WPF element** configuration dialog, select the **MyButton** WPF button and select the **Properties**: tab.
1. Select the IsEnabled element
2. Click in the Link type column
3. Select Authorizations/interlocking from the drop down list
4. Click in the Link column
5. In the drop-down list, select the Authorized option

6. Close the dialog with OK

Compile the Runtime file and note that Authorizations to be Transferred must also be selected. After Runtime has been started, the WPF button is displayed as deactivated on the screen and cannot be operated. If you now log in as the user Test, the button is activated and can be operated. The button is locked again as soon as you log out.

**TRANSFORMATION**

The XAML files must still be adapted to use transformations:

1. switch to the Expression Blend program
2. select MyButton, so that the properties of the element are visible in the events window

3. Under Transform at RenderTransform select the Apply relative transform option
As a result of this, a block is inserted into the XAML file, which save the transformation settings in runtime.

```xml
<Button.RenderTransform>
  <TransformGroup>
    <ScaleTransform ScaleX="1" ScaleY="1" />
    <SkewTransform AngleX="0" AngleY="0" />  
    <RotateTransform Angle="0" />
    <TranslateTransform X="0" Y="0" />
  </TransformGroup>
</Button.RenderTransform>
```

4. Save the file and replace the old version in zenon with this new file.

5. Open the **WPF element** configuration dialog again:
   a) select the **MyButton** button
   b) select the **Transformations** tab
   
   ![Configuration Dialog]
   
   c) select the element **RotateTransform.Angle**
   d) Click in the **Link type** column
   e) Select **Transformations** from the drop down list
   f) Click in the **Link** column
   g) the variable selection dialog is opened
   h) select the **int** variable to link this variable with the **RotateTransform.Angle** property
Compile the Runtime files and start Runtime. Log in as the **Test** user and click on the button. The button has the value **45** and the **WPF element** rotates by 45°.

![Button with 45° rotation](image)

### 6.7.3 Integrate DataGrid Control in zenon

To create DataGrid control for zenon, you need:
- Visual Studio (Visual Studio 2015 in this example)

#### CREATE WPF USER CONTROL

1. In Visual Studio, create a new **Solution** and a **WPF User Control Library** project in .NET Framework version 4.6.2 or higher therein.

   **Info:** If the corresponding project template does not appear in the list of available templates, this can be added by means of the search (field at the top right of the dialog).
In our example, the project is given the name DataGridControlLibrary.

2. Create a new data connection in the Server Explorer.

In our example, the database Northwind is used, which is provided by Microsoft as an example database that can be downloaded for free.

To set up the database connection:

a) Right-click on Data Connections.

b) Select Add connection....

c) Select Microsoft SQL Server (SQLClient) as Data source.

d) Select the corresponding server and database name.
After adding the connection, the Server Explorer window should look a little like this:

A new DataSet is created in the next step.

**CREATING A DATASET**

1. Right-click on the project
2. Select Add – New Item… in the context menu
3. Create a new **DataSet** with the name **DataSet1**.
4. Double click on the DataSet in order to open it in the Designer.
5. Drag the tables that you need (**Customers** and **Orders** in this example) to the DataSet design window.

The XAML file is modified in the next step.
CONFIGURATION OF THE XAML FILE

1. If not already there, add the Namespace as a reference to the class in the XAML file:

```xml
<UserControl xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
             xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
             xmlns:d="http://schemas.microsoft.com/expression/blend/2008"
             xmlns:local="clr-namespace:DataGridControlLibrary"
             d:DesignHeight="300" d:DesignWidth="300">

2. Define the resources and the DataGrid that is to be used in the WPF:

```xml
<UserControl.Resources>
    <local:DataSet1 x:Key="DataSet1"/>
    <CollectionViewSource x:Key="CustomersViewSource" Source="{Binding Path=Customers, Source={StaticResource DataSet1}}"/>
</UserControl.Resources>
```  

```xml
<Grid DataContext="{StaticResource CustomersViewSource}"
    DataContext="{StaticResourceCustomersViewSource}"
    <DataGrid Name="DataGrid1" DisplayMemberPath="CompanyName" ItemsSource="{Binding}" SelectedValuePath="CustomerID" HorizontalAlignment="Stretch" VerticalAlignment="Stretch"/>
</Grid>
```  

3. Open the code-behind file (UserControl1.xaml.cs) and insert the following lines in the constructor:

```csharp
public UserControl1()
{
    InitializeComponent();
    DataSet ds = ((DataSet)(FindResource("DataSet1")));
    DataSet1TableAdapters.CustomersTableAdapter ta = new DataSet1TableAdapters.CustomersTableAdapter();
    ta.Fill(ds.Customers);
    CollectionViewSource CustomersViewSource = ((CollectionViewSource)(this.FindResource("CustomersViewSource")));
    CustomersViewSource.View.MoveCurrentToFirst();
}
```  

In doing so, the following happens:

- The DataSet is obtained
- A new TableAdapter is created
- The DataSet is filled
The information is provided to the DataGrid control.

The solution can now be built.

**BUILD**

Now build the solution. The corresponding DLL *(DataGridControlLibrary.dll)* is created in the output folder of the project.

Now you have a DLL with the necessary functionality available.

However, Zenon can only display XAML files that cannot be linked to the code behind file, which is why an additional XAML file is needed that references the DLL that has just been created.

To do this:

1. Create a further project, again as a **WPF User Control Library**
2. It was called **DataGridControl** in our example.
3. Insert a reference to the project that has just been built into this new project.

4. The XAML files *(UserControl1.xaml)* looks as follows:

```
<UserControl x:Class="DataGridControl.UserControl1"
             xmlns="http://schemas.microsoft.com/winfx/2006/xaml/
             presentation"
             xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
             xmlns:d="http://schemas.microsoft.org/winfx/2006/xaml"
             mc:Ignorable="d"
             d:DesignHeight="300" d:DesignWidth="300">
    <Grid>
    </Grid>
</UserControl>
```

5. Because all necessary content is contained in the DLL that has been created and no code-behind is necessary, delete the following lines:

```xml
x:Class="DataGridControl.UserControl1"
xmlns:local="clr-namespace:DataGridControl"
```

6. Also delete (for the positioning) the following lines:

```xml
mc:Ignorable="d"
d:DesignHeight="300" d:DesignWidth="300"
```
7. Delete the code-behind file (UserControl1.xaml.cs) in this project.

8. Define what is to be displayed in the XAML file.
   To do this, modify the XAML file as follows:
   ```xml
   <UserControl xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
               xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
               xmlns:d="http://schemas.microsoft.com/expression/blend/2008"
               xmlns:dataGridLibrary="clr-namespace:DataGridControlLibrary;assembly=DataGridControlLibrary">
     <Grid x:Name="Grid1">
       <dataGridLibrary:UserControl1 Name="DataGridControl" HorizontalAlignment="Left"
                                      VerticalAlignment="Top"/>
     </Grid>
   </UserControl>
   ``
   The line `xmlns:dataGridLibrary="clr-namespace:DataGridControlLibrary;assembly=DataGridControlLibrary"` defines the namespace `dataGridLibrary` and stipulates that this should use the assembly that has been created.

9. Assign a name for the grid.

10. Insert the control `dataGridLibrary:UserControl1` from our library and give it a name, because zenon can only modify objects that have a name.

11. Build the solution.

In the next step, how the DLL and XAML file are added to zenon is explained.

**STEPS IN ZENON**

1. Open the zenon Editor.
2. Go to File -> Graphics.
3. Select Add file... in the context menu
4. Select the XAML file at the save location (UserControl1.xaml from the DataGridControl project) and add this:

5. Insert the DLL with the functionality for the XAML file.
   To do this:
   a) Select, in the context menu, File -> Other Add file....
   b) Select the file DataGridControlLibrary.dll of the first project (DataGridControlLibrary).

6. Create a zenon screen.

7. Add a WPF element and select the previously-incorporated XAML file.
   You should now see the following in the zenon Editor:

8. Start zenon Runtime in order to also test the control there.
Hint

DLLs that are part of a WPF element can also be replaced during ongoing operation. In doing so, the referencing is via linking in the XAML file.

To replace a DLL:
- Close all zenon screens in which the WPF element is used.
- Close all symbols that use a desired WPF element.
- In Explorer, replace the DLL in the `wpfache` folder of the Editor files. You can find this folder in the SQL directory under...

As an alternative to replacement using Explorer, you can also replace the file in the zenon Editor directly. To do this, carry out the following steps:
- In the Visual Studio project settings, increase the file version of the DLL.
- Create the new DLL.
- Close all zenon screens in which the WPF element is used.
- Close all symbols that use a desired WPF element.
- In the zenon Editor, delete the DLL from the `\Files\Other` folder and add the file with the higher version number.

6.8 Error handling

ENTRIES IN LOG FILES

<table>
<thead>
<tr>
<th>Entry</th>
<th>Level</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xaml file found in %s with different name, using default!</td>
<td>Warning</td>
<td>The name of the collective file and the name of the XAML file contained therein do not correspond. To avoid internal conflicts, the file with the name of the collective file and the suffix <code>.xaml</code> is used.</td>
</tr>
<tr>
<td>no preview image found in %s</td>
<td>Warning</td>
<td>The collective file does not contain a valid preview graphic (preview.png or [names of the XAML file].png). Thus no preview can be displayed.</td>
</tr>
<tr>
<td>Xaml file in %s not found or not unique!</td>
<td>Error</td>
<td>The collective file does not contain an XAML file or several files with the suffix <code>.xaml</code>. It cannot be used.</td>
</tr>
<tr>
<td>Could not remove old</td>
<td>Warning</td>
<td>There is an assembly that is to be replaced with a newer</td>
</tr>
<tr>
<td>Entry</td>
<td>Level</td>
<td>Meaning</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>assembly %s</td>
<td></td>
<td>version, but cannot be deleted.</td>
</tr>
<tr>
<td>Could not copy new assembly %s</td>
<td>Error</td>
<td>A new version is available for an assembly in the work folder, but it cannot be copied there. Possible reason: The old example is still loaded, for example. The old version continues to be used, the new version cannot be used,</td>
</tr>
<tr>
<td>file exception in %s</td>
<td>Error</td>
<td>A file error occurred when accessing a collective file.</td>
</tr>
<tr>
<td>Generic exception in %s</td>
<td>Error</td>
<td>A general error occurred when accessing a collective file.</td>
</tr>
</tbody>
</table>